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Content

Integration

Junit Tests

TMF - Project View

TMF - EventsEditor

TMF - BookmarksView

TMF - Filters View

TMF - Colors View

TMF - Histogram View

TMF - Sequence Diagram
TMF - Statistics View

TMF - Time Chart View

TMF - Custom Parsers

TMF - State System Explorer
TMF - Call Stack View
LTTng 2.0 - Control Flow View
LTTng 2.0 - Resources View
LTTng 2.0 - Control View
GDB Tracing

Tracing RCP

LTTng 2.0 - Memory Analysis
LTTng 2.0 - CPU Analysis
Trace Synchronization

XML analysis

To do
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Pass

Fail

Total
2
18
145
36
17
12
6
50
37
17
26
27
14
22
45
36
107
28
31
20
25
13
39

With comments
With comments
With comments
With comments

With comments
With comments
With comments
With comments
With comments

With comments

With comments
With comments
With comments
With comments
With comments
With comments
With comments



24

Network Trace analysis

Bug Reports

Total:

0 11 (O 1 |

0 773 11 784
Open Fixed Total

10 11 21




Section
Integration

Target Windows 8.1 64 bit

Step Test Case

1
1.1

1.2
1.3
1.4
1.5

2

2.1

2.2
2.3
2.4
2.5

2.6
3
3.1

3.2
33
3.4
3.5

3.6
4
4.1

4.2
4.3
4.4
4.5

4.6

wn

5.1

5.2

5.3

Verify C/C++ EPP Package RC1
Download EPP Package

Version of Tracing Features
TMF presence
LTTng presence

GDB Tracepoint Analysis presence

Luna Update Site
Verify C/C++ EPP Package RC2

Download EPP Package

Version of Tracing Features
TMF presence
LTTng presence

GDB Tracepoint Analysis presence

Luna Update Site

Verify C/C++ EPP Package RC3
Download EPP Package

Version of Tracing Features

TMF presence

LTTng presence

GDB Tracepoint Analysis presence
Luna Update Site

Verify C/C++ EPP Package RC4
Download EPP Package

Version of Tracing Features
TMF presence
LTTng presence

GDB Tracepoint Analysis presence
Luna Update Site
Verify Update Site

Luna Update Site

Linux Tools Update Site

Upgrade using Luna Update Site

Action

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installion Details
Open Tracing perspective
Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Update site "Luna -
http://download.eclipse.org/releases/luna"

Download, extract and start EPP package. Check the mailing list for the pac

https://dev.eclipse.org/mailman/listinfo/epp-dev

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective
Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site
"http://download.eclipse.org/releases/maintenance”

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective
Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site
"http://download.eclipse.org/releases/maintenance”

Download, extract and start EPP package

Go to Help -> About Eclipse -> Installation Details
Open Tracing perspective
Open LTTng Kernel perspective

Open GDB Trace perspective

Go to Help -> Install New Software... -> Use the testing update site
"http://download.eclipse.org/releases/maintenance”

Download Eclipse standard and install LTTng Kernel, LTTng Control,

LTTng UST, GDBTrace and PCAP Network Analysis from main Luna SR1

testing Update site
http://download.eclipse.org/releases/maintenance

Download Eclipse standard and install LTTng Kernel, LTTng Control,

LTTng UST, GDBTrace and PCAP Network Analysis from the Linux Tools

Update site
http://download.eclipse.org/linuxtools/update-luna-sr1-rc3a

Download Eclipse standard from Luna SRO and install LTTng, LTTng

Kernel, GDBTrace and PCAP Network Analysis from main Luna Update

site.

http://download.eclipse.org/releases/luna

Try to update the installation using the testing Luna SR1 update site.
http://download.eclipse.org/releases/maintenance

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng, CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab

EPP Package starts

Verify that all tracing features and plug-ins are present and have the
correct version (TMF, LTTng Control, LTTng Kernel, LTTng UST,
CTF, GDBTrace)

Tracing perspective opens
LTTng Kernel perspective

GDB Tracepoint analysis perspective

Verify that all LTTng Kernel, LTTng UST and GDB Trace are availab

Verify that installation was successful

Verify that installation was successful

Verify that installation was successful

To Do

N/A
N/A
N/A
N/A
N/A

N/A

N/A
N/A
N/A
N/A
N/A

N/A

N/A

N/A
N/A
N/A
N/A

N/A
N/A
N/A
N/A

N/A
N/A

N/A

N/A

N/A

N/A

Comment

Comment



5.4

5.5

6.1

6.2

Upgrade using Linux Tools Update Site

Upragde from previous EPP

Verify Update Site

Trace Compass update site

Upgrade using Trace Compass
update site

Download Eclipse standard from Luna SRO and install LTTng, LTTng

Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Luna

SRO Linux Tools Update site.

http://download.eclipse.org/linuxtools/update-3.0

Try to update the installation using the Luna SR1 Linux Tools Update site.
http://download.eclipse.org/linuxtools/update-luna-sr1-rc3a Verify that installation was successful

Download Eclipse previous C/C++ EPP package. Try to upgrade using both
update sites:

https://hudson.eclipse.org/packaging/job/luna.epp-tycho-
build/128/artifact/org.eclipse.epp.packages/archive/repository/
http://download.eclipse.org/releases/staging/

The information about the update sites to use is usually posted on epp-dev Verify that installation was successful

Release outside release train

Download Eclipse standard and install LTTng Kernel, LTTng Control, LTTn
UST, GDBTrace and PCAP Network Analysis from main
Update site: http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

Download Eclipse standard from Luna SRO and install LTTng, LTTng

Kernel, LTTng UST, GDBTrace and PCAP Network Analysis from the Luna

SRO Linux Tools Update site.

http://download.eclipse.org/linuxtools/update-3.1

Try to update the installation using the Trace Compass update site.
http://download.eclipse.org/tracecompass/stable/repository/ Verify that installation was successful

N/A

N/A



Section Pass

Junit Tests

Ubuntu 12.04 64 bit and on

Target Hudson

Step Test Case Action
1 Junit Test Cases
1.1 CTF Core Tests Plug-in Run manually or with Jenkins
1.2 CTF Parser Tests Plug-in Run manually or with Jenkins
1.3 State System Core Tests Plug-in  Run manually or with Jenkins
1.4 TMF Core Tests Plug-in Run manually or with Jenkins
1.5 TMF Ul Tests Plug-in Run manually or with Jenkins
1.6 TMF Ul SWTBot Tests Plug-in Run manually or with Jenkins
CTF Support for TMF SWTBot
1.7 Tests Plug-in Run manually or with Jenkins
TMF Xml Analysis Core Tests
1.8 Plug-in Run manually or with Jenkins
TMF Xml Analysis Ul Tests Plug-
1.9 in Run manually or with Jenkins
1.10 LTTng Control Core Tests Plug-in Run manually or with Jenkins
1.11 LTTng Control Ul Tests Plug-in  Run manually or with Jenkins
LTTng Kernel Analysis Core Tests

1.12 Plug-in Run manually or with Jenkins
LTTng Kernel Analysis Ul Tests

1.13 Plug-in Run manually or with Jenkins
LTTng Kernel Ul SWTBot Tests

1.14 Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis

1.15 Core Test Plug-in Run manually or with Jenkins
LTTng Userspace Tracer Analysis

1.16 Ul Test Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Core

1.17 Tests Plug-in Run manually or with Jenkins
GDB Tracepoint Analysis Ul Tests

1.18 Plug-in Run manually or with Jenkins

Verification

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed

All test cases passed
All test cases passed

All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed
All test cases passed

All test cases passed

Fail

To Do

Comment

[ 0 o

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



Section Pass Fail ToDo Comment

TMF - EventsEditor 36 L

Target:
Step Test Case Action Verification Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. Pass When opening a garbage file, it passes as BTF

2 Trace bookmarks

2.1 Show Bookmarks View  Select Bookmarks view (bottom folder) Bookmaks view is shown Pass
Views are populated. Verify that an Events editor is
2.2 Open trace Open an LTTng CTF Kernel trace opened showing LTTng Kernel specific columns Pass

Add a bookmark, by

a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of
b) right-clicking the margin and select Add bookmark.... the event row and is added to the Bookmarks view with
) using the Edit > Add bookmark... menu. relevant information (i.e. Description entered and
2.3 Add Trace Bookmark Enter the bookmark description in dialog box correct trace resource) Pass

Scroll within event table so that bookmark is not visible
anymore and then double-click on bookmark in Bookmarks ~ Make sure that event with bookmark is selected and

2.4  Open Trace Bookmark (1) View visible in event table Pass
Open another trace #2 and then double-click on bookmark in Make sure that correct trace #1 is brought to top and

2.5 Open Trace Bookmark (2) Bookmarks view correct event with bookmark is selected in events table|  Pass
Close the trace #1 and then double-click on bookmark in Make sure that correct trace #1 is opened and correct

2.6 Open Trace Bookmark (3) Bookmarks view event with bookmark is selected in events table Pass

Make sure that bookmark icon is removed from event
Delete Bookmark (from  Select bookmarks icon in event table right-click oniconand  table and corresponding bookmark is removed from

2.7  table) select "Remove Bookmark the Bookmarks view Pass
Add a bookmark (see 6.4), then select bookmark in Make sure that bookmark icon is removed from event
Delete Bookmark (from  Bookmarks view, right mouse click and select "Delete". table and corresponding Bookmark is removed from
2.8 Bookmarks view) Confirm the deletion. the Bookmarks view Pass
3 Experiment bookmarks
Create and open Create Experiement with 2 LTTng CTF Kernel traces init and Verify that an Events editor is opened showing LTTng
31 experiment open experiment Kernel specific columns Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of
b) right-clicking the margin and select Add bookmark.... the event row and is added to the Bookmarks view with
Add Experiment ¢) using the Edit > Add bookmark... menu. relevant information (i.e. Description entered and
3.2 Bookmark Enter the bookmark description in dialog box correct experiment resource) Pass
Scroll within event table so that bookmark is not visible
Open Experiment anymore and then double-click on bookmark in Bookmarks  Make sure that event with bookmark is selected and
3.3 Bookmark (1) View visible in event table Pass
Make sure that correct experiment #1 is brought to top
Open Experiment Open another trace #2 and then double-click on bookmark in and correct event with bookmark is selected in events
3.4 Bookmark (2) Bookmarks view table Pass
Open Experiment Close the experiment #1 and then double-click on bookmark Make sure that correct experiment #1 is opened and
3.5 Bookmark (3) in Bookmarks view correct event with bookmark is selected in events table|  Pass

Make sure that bookmark icon is removed from event
Delete Bookmark (from  Select bookmarks icon in Events view, right-click on icon and table and corresponding bookmark is removed from

3.6 table) select "Remove Bookmark" the Bookmarks view Pass
Add a bookmark (see 6.4), then select bookmark in Make sure that bookmark icon is removed from event
Delete Bookmark (from  Bookmarks view, right mouse click and select "Delete". table and corresponding Bookmark is removed from

3.7  Bookmarks view) Confirm the deletion. the Bookmarks view Pass



4.4

44

4.5
4.6
4.7

5.1

52

53

5.4

55

6.1

6.2

6.3

6.4

6.5

71

7.2

Filter

Filter

Cancel filter

Un-filter
Filter & Search
Search & Filter

Time Synchronization
Mouse synchronization
Key synchronization
Search synchronization
External synchronization

Range selection

Event Synchronization

Open trace

Mouse synchronization

Key synchronization

Search synchronization

External synchronization

Source Code / Model
Lookup

Preparation

Open call site

In the filter bar, enter some regex

In the filter bar, enter some regex, then quickly press ESC
before filtering is done

::n the filter bar, clear the regex, or press DEL while table has
ocus

In the filter bar, enter some regex; likewise in the search bar
In the search bar, enter some regex; likewise in the filter bar

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time.

Select an event with left button, press shift key and click select
another event

Open an LTTng CTF Kernel trace

Select any event in the table with the mouse button

Select any event in the table using Up, Down, PageUp,
PageDown, Home, End

In the search bar, enter some regex, then search again with
Enter/Shift-Enter

In any other view that supports time synchronization, select a
time. The selected event in the editor is updated. Then give
focus back to the editor.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Unzip traces/c_project_callsite.zip and
traces/callsite.zip to your local disk.

3) Import demo C project to the Eclipse workspace of zip
file c_project_callsite.zip

4) Import the test trace of zip Ffile callsite.zip to a tracing
project.

Select trace type "Generic CTF Trace" and open the trace
1) select event in table

2) click right mouse button
3) select "Open Source Code" menu item

Only events matching regex are displayed. Top and
bottom fFilter status rows update while filtering is
ongoing. When filtering is done, status rows show
number of matching events.

Only some events matching regex are displayed. Status
rows show partial number of matching events, with
different 'stop" icon.

All events are displayed. Selected event remains
selected and visible. Status rows are removed.

Events are filtered and highlighted accordingly
Events are filtered and highlighted accordingly

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

Other views are synchronized to the selected event's
time

The first event at or following the selected time is
selected and visible.

Range of events are highlighted. Selection range is
updated in other views that support range selection

Verify that an editor is opened showing LTTng Kernel
specific columns. Views are updated with the new
trace.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

The Properties view is updated with the selected
event's Property and Value. Timestamp and Content
are expandable.

Verify that correct source code file and line number is
opened



7.3

7.4

8.1

8.2

Open call site (no source
code)

Open model URI

Export to text

Export CTF trace

Export Other Trace

1) Close source code project

2) select event in table

3) click right mouse button

4) select "Open Source Code" menu item

1) select event in table (e.g. 1st event)
2) click right mouse button
3) select "Open Model Element" menu item

1) Open a CTF trace (e.g. LTTng Kernel)
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

1) Open a trace other than CTF trace
2) Click right mouse button

3) Select "Export To Text" menu item
4) Enter a file name and location

5) Press OK

Since the source code is not available the no source
code file is opened. Instead a error dialog is opened
(with title "FileNotFoundException")

Since the model is not available the model element is
not shown. Instead a error dialog is opened (with title
"FileNotFoundException")

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the
events table and that they are separated by tab
character.

Make sure that a progress monitor dialog is opened
during the export. After finishing make sure that the
text file exists and it contains the events stored in the
file. Verify that the columns are printed as shown in the
events table and that they are separated by tab
character.



Section
TMF - Project View
Target: Ubuntu 14.10 64 bit

Step Test Case

1 Preparation
11 Step 1
1.2 Step 2

2 Project Creation
2.1 New Project Wizard
2.2 Create project
2.3 Project structure

3 Traces Folder

Preparation
31 Traces Folder menu
3.2 Trace Import Wizard

Import single custom text trace

3.3 (link to workspace)

Import Single custom XML trace

3.4 (link to workspace)

Import LTTng Kernel CTF trace

3.5 (link to workspace)

3.6 Rename + copy import

3.7 Overwrite + copy import

38  Skip

3.9  Default overwrite

3.10  Import unrecognized

3.11  Import unrecognized (ignore)

Preparation

Import CTF trace by selection

3.12  metadata file only
Preparation

Pass
142

Action

Open LTTng Kernel perspective

Open Navigator View (used for independent verification)

Open New Tracing Project Wizard
Specify a project name and finish
Open the new Tracing project

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import Custom Text and XML parsers

(ExampleCustomXmlParser.xml,

ExampleCustomTxtParser.xml) from directory
traces/customParsers into your workspace from the

Manage Custom Parsers dialog.

Select the Traces folder and open its context menu

Select Import

1) Browse to directory ${local}/traces/import/

2) Select trace ExampleCustomTxt.log

3) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

4) press Finish

redo 3.1-3.3 but this time select ExampleCustomXml.xml

redo 3.1-3.3 but this time select directory kernel-overlap-

testing/

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to

workspace"

When dialog box appear select Rename

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to

workspace"

When dialog box appear select Overwrite

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to

workspace"

When dialog box appear select Skip

redo 3.3, 3.4, 3.5. However, Unselect "Create Links to
workspace" and select "Overwrite existing without warning"

1) Open Import wizard (see 3.1-3.2)
Zg Browse to directory ${local}/traces/import
3

Select trace unrecognized.log

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

redo 3.10, however unselect "Import unrecognized traces"

Delete all traces in project

Redo 3.5, However only select metadata file instead of

directory trace
Delete all traces in project

Fail

Verification

LTTng perspective opens with correct views

Navigator View opens

Tracing Project Wizard opens

Tracing project appears in Project Explorer/Navigator
Project contains Experiments and Traces folders

Correct menu opens (Import, Refresh)

Trace Import Wizard appears

Imported trace appear in Traces Folder and the Trace
Type Tmf Generic is set. Make sure trace can be opened

Imported trace appear in Traces Folder and the Trace
Type "Custom XML log" is set. Make sure that trace can

be opened

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be

opened

Traces are imported with new name that has a suffic (2)
at the end. Make sure that imported traces are copied

to the project.

Existing traces are deleted and new traces are
imported. Make sure that imported traces are copied to

the project and can be opened

Make sure that no new trace is imported

Make sure that no dialog box appears (for renaming,
overwriting, skipping) and existing traces are
overwritten). Make sure trace can be opened

unrecognized.log is imported with trace type unknown.
The default text file icon is displayed. The trace, when
opened, is displayed in the text editor.

unrecognized.log is not imported

Imported trace appear in Traces Folder and the Trace
Type "LTTng Kernel" is set. Make sure that trace can be

opened

Type

SWTBot
SWTBot

SWTBot
SWTBot
SWTBot

SWTBot
SWTBot

SWTBot

Manual

Manual

Manual

Manual

Manual

Manual

Manual

Manual

To Do

Comment

[ o b

Pass
Pass

Pass
Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Either the text editor will open or the system editor, depending on the file associations in your installation

Fixed with confidence 0 patch ( | know it passes this test)



3.13

3.14

3.15

3.16

3.17

3.18

3.19

3.20

Recursive import with auto-
detection (Rename All)

Preparation

Recursive import with auto-
detection (Overwrite All)

Preparation

Recursive import with auto-
detection (Skip All)

Preparation

Recursive import with auto-

detection (test rename, overwrite

and skip)
Preparation

Recursive import with specific
trace type 1 (Skip Al

Preparation

Recursive import with specific
trace type 2 (Skip All)

Preparation

Recursive import with specific
trace type 3 (Skip All)

Preparation

Recursive import with specific
trace type 4 (Skip All)

Preparation

1) Open Import wizard gsee 3.1-3.2)

2) Browse to directory ${local}/traces/import

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces", unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select "Rename All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select Overwrite All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.

2) Browse to directory ${local)/traces/|mport/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning" and
select "Create Links to workspace" and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3

2) Browse to directory $(local}/traces/|mport/

3) select directory import

4) Keep <Auto Detection>, Select "Import unrecognized
traces”, unselect "Overwrite existing without warning",
select "Create Links to workspace" and unselect "Preserve
Folder Structure"

5) press Finish

6) When dialog appears select "Rename"

7) When dialog appears select "Overwrite"

8) When dialog appears select "Skip"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Generic CTF Trace", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure"and

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local)/traces/|mport/

3) select directory import

4) Select trace type "LTTng Kernel Trace", Select "Import
unrecognized traces”, unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "L'I'I'ng UST Trace", Select "Import

unrecognlzed traces", unselect "Overwrite eX|st|ng without

warnlng select "Create Links to workspace" and unselect
"Preserve Folder Structure"

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", Select "Import
unrecognized traces", unselect "Overwrite existing without
warning", select "Create Links to workspace" and unselect
"Preserve Folder Structure”

5) press Finish

6) When dialog appears select Skip All"

Delete all traces in project

All Traces are imported with respective trace type set.
Traces with name clashes are imported with suffix (2).
1 trace (unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which

have a trace type set. The unknown trace type should

open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are overwritten . 1 trace
(unrecognized.log) is imported with trace type
unknown. Make sure that traces can be opened which
have a trace type set. The unknown trace type should
open with the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are not imported. 1 trace
(unrecognized.log) is imported with trace type
unknown. The unknown trace type should open with
the text editor.

All Traces are imported with respective trace type set.
Traces with name clashes are either renamed,
overwritten or skipped as per dialog action. Make sure
that traces can be opened which have trace type set.
Tge unknown trace type should open with the text
editor.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

4 CTF traces are imported with trace type "Generic CTF
Trace" . Make sure that these traces can be opened

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

One LTTng Kernel trace is imported with trace type
"LTTng Kernel Trace". Make sure that this trace can be
opened.

After selecting trace type, verify that button "Import
unrecognized traces" is disabled.

3 LTTng UST traces are imported with trace type
"LTTng UST Trace". Make sure that these traces can be
opened.

All text files in directories are imported as trace and
trace type "Tmf Generic" is set. Note that trace type
validation only checks for file exists and that file is not

a directory. Make sure that these traces can be opened.

However traces with wrong trace type won't show any
events in the table.



3.21

3.22

3.23

3.24

3.25

3.26

3.27

3.28
3.29

3.30

3.31

3.32

333

334

3.35

3.36

3.37

Import CTF trace by selection
metadata file only

Import to default project

Import wizard with no project
selecte

Preparation

Redo 3.5, However only select metadata file instead of
directory trace

1) Delete project "Tracing”
2) Import a trace using import wizard (File > Import... >
Tracing > Trace Import)

Open import wizard while not having a project seleted
Delete all traces in project
D&D a few LTTng traces from another Tracing project's

Drag and Drop from other Tracing Traces folder

Drag and Drop from non-Tracing

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Import destination
Preparation

Recursive import with preserved
folder structure

Recursive import with preserved
folder structure (Skip All)

Recursive import with preserved
Folder structure (Rename All)

Preparation

Delete with mixed selection of
traces and folders

Delete multiple folders

Clear single Traces folder

Clear multiple Traces folder
Preparation

Import from archive, preserve
folder structure

Preparation

D&D a few files from a non-Tracing project

D&D a few files from an external file manager

I1:)l[d)&D a trace with name of an existing trace into traces
olaer
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder
Open Import wizard

Delete all traces in project

1) Open Import wizard (see 3.1-3

2) Browse to directory $(local}/traces/|mport/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite

existing without warning", select "Create Links to workspace"

and select "Preserve Folder Structure"
5) press Finish

1) Open Import wizard (see 3.1-3.2)

23 Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Generic", unselect "Overwrite

existing without warning", select "Create Links to workspace"

and select "Preserve Folder Structure"
5) press Finish
6) When dialog appears select "Skip All"

1) Open Import wizard (see 3.1-3.2)

2) Browse to directory ${local}/traces/import/

3) select directory import

4) Select trace type "Tmf Genenc unselect "Overwrite

existing without warning", select " ‘Create Links to workspace"

and select "Preserve Folder Structure”
5) press Finish
6) When dialog appears select "Rename All"

Delete all traces in project

1) Create a trace folder under the "Traces" folder

2) Import 2 traces under the folder

3) Open one of the traces.

4) Select the trace folder and both traces in the Project
Explorer view

5) Right-click, Delete. Click OK.

1) Create 2 trace folders under the "Traces" folder
2) Import a trace in each folder

3) Select both trace folders

4) Right-click delete

1) Add a few folders and traces under the Traces folder
2) Right-click on the Traces folder, Clear. Click OK.

13 Create 2 trace projects, both containing a few traces.
2) Select both Traces folder
3) Right-click on one of the trace folders, Clear. Click OK.

Delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

CTF trace is imported with correct trace type set. Trace
can be opened.

Make sure the project with name Tracing is created and
trace is imported to that project.

Verify that "Into Folder" points to project
Tracin%/Traces. Also make sure that project Tracing was
create

Selected traces are added to the Traces folder with
proper icon. Trace can be opened.

Selected traces are added to the Traces folder with
dgFault icon. Files can be opened wit the default
editor.

Selected traces are added to the Traces folder with
default icon. For actual traces Trace type is detected
automatically. Trace can be opened, For non traces the
files are added with default icon and they can be
opened with the default editor.

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a suffix 2

Verify that trace is added into the traces folder with
the trace name of the orignal trace plus a sufFfix 3

Verify that "Into Folder" text box cannot be updated

All Traces are imported with respective trace type set.
The folder "clashes" is imported with its traces inside.
Make sure that traces can be opened which have a
trace type set.

The wizard should finish quickly as no trace will be
imported. Make sure that traces can be opened which
have a trace type set.

All Traces are imported with respective trace type set
with suffix (2). The folder "clashes" is imported with its
traces inside. Make sure that traces can be opened
which have a trace type set.

A dialog should ask the user to confirm deletion of the
selected elements. Clicking OK should remove all that
was selected. The editor should be closed
automatically.

A dialog should ask the user to confirm deletion of the
folders. Clicking OK should remove all that was
selected.

A dialog should ask the user to confirm the clear of the
Fotder. glicking OK should everything under all that was
selected.

A dialog should ask the user to confirm the clear of the
folders. Clicking OK should everything under all that
was selected.

4) Select trace type "Automatic”, unselect "Overwrite existing All the files get imported under their respective

without warning" and select "Preserve Folder Structure"
5) press Finish

Delete all traces in project

folders. The CTF traces can be opened (kernel-overlap-
testing, simple_server...)



3.38

3.39

4.1
4.2
4.3
4.4
4.5
4.6
4.7

4.8

4.9

5.1
52

6.1
6.2
6.3
6.4

6.5
6.6
6.7
6.8
6.9

6.10

6.11

71
7.2

7.3

7.4

7.5

7.6

7.7

7.8

7.9

6.11

Import from archive, no preserve

folder structure
Preparation

Import from archive, rename all

Trace

Trace menu

Open trace

Copy trace

Rename trace

Delete trace

Open Trace (Accelerator)
Delete Trace (Accelerator)

Open Trace (double click)

Open Trace (already open)

Experiments Folder

Experiments menu
Create experiment

Experiment
Experiment menu
Select Traces dialog
Select traces

Open experiment

Copy experiment
Rename experiment
Delete experiment

Open Experiment (Accelerator)
Delete Experiment (Accelerator)

Delete Experiment (open
experiment)

Select Traces while Experiment is

open

Experiment Traces
Trace menu
Open trace

Remove trace

Drag and Drop from Traces

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

All the files get imported. The CTF traces can be
opened (kernel-overlap-testing, simple_server...). The

4) Select trace type "Automatic", unselect "Overwrite existing traces with name clashes are added with the trace

without warning" and unselect "Preserve Folder Structure"
5) press Finish
6) Select Rename All when dialog comes up.

DO NOT delete all traces in project

1) Open Import wizard (see 3.1-3.2)
2) Select archive file: traces.zip
3) select directory the root directory

name of the orignal trace plus a suffix 2
(ExampleCustom*, kernel-overlap-testing,
simple_server...).

4) Select trace type "Automatic”, unselect "Overwrite existing All the files get imported. The CTF traces can be

without warning" and unselect "Preserve Folder Structure"

5) press Finish
6) Select Rename All when dialog comes up.

Select an LTTng trace and open its context menu

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Reopen.
Select the Delete menu and confirm deletion

Select trace and press Enter

Select trace and press Delete and confirm deletion

Double-click a trace

Open two traces. Open the first trace again.

Select the Experiments folder and open it context menu
Select the New menu and provide experiment name

Select an experiment and open its context menu
Select the Select Traces menu

Select a few LTTng traces and finish

Select the Open menu

Select the Copy menu and provide a new name. Open.
Select the Rename menu and provide a new name. Open.
Select the Delete menu and confirm deletion

Select an Experiment and press Enter

Select an Experiment and press Delete and confirm deletion

Open an experiment, select expereiment and press Delete
and confirm deletion

Open an experiment and select an additional trace (see 6.3)

Select an LTTng trace and open its context menu
Select the Open menu

Open Experiment, select the Remove menu and confirm
removal

D&D a few LTTng traces from the Traces directory
D&D a few LTTng traces from another Tracing project's

Drag and Drop from other Tracing Traces folder

Drag and Drop from non-Tracing D&D a few files from a non-Tracing project

Drag and Drop from external

Drag and Drop of trace with
existing name

Drag and Drop of trace with
existing name (2nd time)

Drag and Drop of trace while
Experiment is open

D&D a few files from an external file manager

opened (kernel-overlap-testing, simple_server...). The
traces with name clashed are added with the trace
name of the orignal trace plus a suffix 2 or 3 or 4.

Correct menu opens (Open, Copy, Rename, ...)
Trace is opened and views are populated
Trace is replicated under the new name

Trace is renamed. The trace editor is closed.
Trace is deleted. The trace editor is closed.
Trace is opened

Trace is deleted. The trace editor is closed.

Trace is opened

The first trace editor is simply brought to front.

Correct menu opens (New, Import XML Analysis,
Refresh)

Experiment appears under folder, no traces yet

Correct menu opens (Select, Open, Copy, Rename, ...)
Select Traces dialog is open and populated w/ traces
Selected traces are imported in the experiment
Experiment is opened and views are populated

Experiment is replicated under the new name
Experiment is renamed

Experiment is deleted

Experiment is opened

Experiment is deleted

Experiment is closed and deleted

Experiment is closed and selected traces is imported to
the experiment

Correct menu opens w/ Copy disabled + Remove
Trace is opened and views are populated

Experiment is closed, trace is removed from
experiment

Selected traces are added to the experiment with
proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.
Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

Selected traces are added to the experiment + Traces
with proper icon. Experiment can be opened.

1) D&D a trace with name of an existing trace into experiment Verify that trace is added into the traces folder and

folder
2) Confirm the renaming of traces

Redo test 7.8 with the same trace and same destination
folder

Open an experiment and D&D a trace from the Traces
directory (see 7.4

experiment folder with the trace name of the orignal
trace plus a suffix 2

Verify that trace is added into the traces folder and
experiemnt folder with the trace name of the orignal
trace plus a suffix 3

Experiment is closed and selected traces is imported to
the experiment

Failed in 3.0, 3.1 When copying a renamed experiment the orignal named experiment is recreated. http
Bug after copying an experiment twice: there is a dialog "No trace type associated to that trace..."
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455414

Experiment cannot be opened. Seems right



8.1
8.2
8.3
8.4

8.5

9.1

9.2

9.3

9.4

10

101

10.2
10.3

10.4
10.5

10.6

1

1.1

1.2

1.3

11.4

11.5

11.6

1.7

11.8

11.9

11.10

1.1

11.12

Propagation
Preparation

Rename propagation
Delete propagation
Propagate trace type 1

Propagate trace type 2

Properties View
Synchronization

Trace synchronization

Other trace nodes
synchronization

Check trace properties

Check trace properties -
experiment

Trace Type Selection

Preparation
Trace properties
Trace filtering

Set trace type
Updated trace filtering

Selection of Generic CTF Traces

Supplementary Files

Preparation

Create Supplementary File (State

History File) from trace

Trace Context sensitive menu

Delete Supplementary Files

Action

Select and delete State History

File

Create Supplementary File (State
History File) from experiment

Delete Supplementary Files

Action

Select and delete State History

Select and delete multiple State

History files

Delete Trace

Delete Experiment

Delete Experiment Trace

Copy experiment

In Traces folder, rename a trace showing in both experiments
In Traces folder, delete a trace showing in both experiments

Add a trace to 2 experiments. Change its type from Traces

Add a trace to 2 experiments. Change its type from one of
the experiments

Select a trace under a Traces folder in Project Explorer view.

Repeat with trace under an Experiment.

Select a Traces folder, Experiments folder, or an experiment

in Project Explorer view.

Open an LTTng kernel trace, click on the trace, check the new

properties view.

Open an experiment which containes LTTng kernel traces,
click on the experiment, check the new properties view.

Import an LTTng CTF Kernel trace w/o specifying type (drag

and drop a folder containing the trace, or drag and drop to
the Navigator view)

Select the trace and open the Properties View
Select an experiment and open Select Traces dialog

Select the trace and set its type to “Common Trace Format >

Kernel trace”
Select an experiment and open Select Traces dialog

Repeat 10.1-10.5 with trace type “Common Trace Format >

Generic CTF trace”

1) In Project Explorer remove filter for hidden resources

(Coolbar menu > Customize View... > unselect '.* resources)

2) Create Experiment with 2 LTTng CTF traces in it

Open a LTTng CTF trace and wait for indexing to finish
a) Select trace under Folder Traces and click right mouse
button

b) Redo test: Select trace under Experiment Folder

) Redo test: Select Experiment

1) Select trace and click right mouse button
2) Select 'Delete Supplementary Files...'

Select <trace name>/StateHistory.ht file and click on 'Ok’

Open Experiment with 2 LTTng CTF traces

1) Select Experiment and click right mouse button
2) Select 'Delete Supplementary Files...'

Select one history file (<trace name>/StateHistory.ht) and
click on 'Ok’

1) Redo 11.2and 11.6
2) Select both history files and click on 'Ok’

a) Redo 11.2 to create Supplementary File
b) Delete trace

a) redo 11.6 to create experiment and Supplementary File
b) delete Experiment

a) redo 11.6 to create experiment and Supplementary File
b) remove traces under Experiment

Selected experiment is replicated

New name is propagated to both experiments
Selected trace is removed from both experiments
All occurences of that trace are updated

All occurences of that trace are updated

The Properties view is updated with the selected
trace's "Resource properties" Property and Value. The
"Info > type" property shows the selected trace
category and trace type name.

The Properties view is updated with the selected item's
Property and Value. For Experiment verify the "type"
property is set.

The "Trace properties" should be populated

The "Trace properties" should be populated for every
subtrace

Imported trace appear in Traces with default icon.
Trace cannot be opened.

Selected trace type is blank
Untyped trace does not appear in list

Selected trace now has proper icon. Verify trace type in
Properties View. Trace can be opened.

Trace now appears in list

Verify that .tracing directory is shown under the project

Verify that StateHistory.ht is created under
.tracing/<trace name>/‘,l

Verify that menu item 'Delete Supplementary Files...' is
shown in the context-sensitve menu

Verify that confirmation dialog box is opend and <trace
name>/StateHistory.ht is listed

Make sure that file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Verify that two StateHistory.ht files are created under
.tracing/<trace1 name>/ and ./tracing/<trace2 name>r/
respectively. Also verify, that supplementatry folder for
the experiment ./tracing/<exp name>_exp is created.

Verify that confirmation dialog box is opend and shows
3 root entries:

<exp name>, <trace1 name> and <trace2 name>, with
their respective supplementary files below

Make sure that the selected file .tracing/<trace
name>/StateHistory.ht is deleted from the project
explorer view

Make sure that both history files are deleted under
.tracing/<trace1 name>/ and .tracing/<trace2 name>/
respectively

Verify that supplementary directory .tracing/<trace
name>/ is deleted.

Verify that supplementary File StateHistory.ht

.tracing/<trace1 name>/ and ./tracing/<trace2 name>/

are NOT deleted. Also verify that the supplementary

Zolldergor the experiment ./tracing/exp_name_exp is
eleted.

Verify that supplementary File StateHistory.ht
.tracing/<trace1 name>/ and ./tracing/<trace2 name>/
are NOT deleted

N/A  New feature ... not implemented yet

In future we might want to have the trace type set by auto-detection



11.13

12

121

12.2

123

12.4

12.5

12.6
13

131

13.2

133

13.4

13.5

13.6

13.7

13.9

13.10

13.11

13.12

13.13

13.14

13.15

13.16
14

Delete Supplementary Files
Action while trace is open

Link With Editor

Preparation

Select trace/experiment in Editors Select several traces and experiments one after each other in

area

Select opened
traces/experiments in Project
Explorer

Preparation

Select trace/experiment in Editors Select several traces and experiments one after each other in

area

Select opened
traces/experiments in Project
Explorer

Trace Package Export Wizard

Preparation

Open the trace package export
wizar

Select Traces

Deselect/Select All

Trace element selection

Trace sub-element selection

Select/Deselect All

Archive file selection

Change export options, change
compression

Change export options, change
format

Change export options, change
format and compression

Finish the wizard

Overwrite

Verify formats

Verify content

Partial selection
Trace Package Import Wizard

Open trace and then redo 11.4

1) In Project Explorer make sure that "Link with Editor"
button is selected
2) Open multiple traces and experiments

Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) In Project Explorer make sure that "Link with Editor"

button is not selected
2) Open multiple traces and experiments (if not open)

Editors area

Select several open traces and experiments one after each
other in Project Explorer

1) Implort 2 traces that generate supplementay files (trace2,

kernel_vm,
2) Open both traces, wait for the indexing to finish
2) Add bookmarks in the two traces

Click on “File”, "Export...", “Tracing”, “Trace Package Export”

and click Next

On the left side, select the project in which the traces were

imported. Then on the right side, selected both traces.

With traces selected, press the Deselect All button. Then
press on the Select All button. Click Next.

Unselect the trace2 element

Unselect the kernel_vm > Trace element

With nothing selected, click Select All. Then click Deselect All.

Then click Select All again.

1) Click on the Browse button.
2) Select a location on the filesystem
3) Enter the file name export.tar

Unselect the “Compress” checkbox.
Change to Zip format

Change to Tar format then select the Compress checkbox.

Click Finish

Open the wizard again and select the traces (step 13.2, 13.3).

Click Finish.

Open the wizard again and select the traces (step 13.2, 13.3).

This time, choose Zip format. Click Finish.

Open the tar.gz and the zip files in an archive manager.

Open the wizard again and select the traces (step 13.2, 13.3).
This time, unselect both Supplementary files subtrees. Click

Finish.

Verify that trace is closed and supplementary files are
deletes

Verify that after each selection the corresponding trace
or experiment element is selected in the Project
Explorer

Verify that after each selection the corresponding trace
or experiment is brought to the top in the Editors area

Verify that selection in Project Explorer doesn't change

Verify that Editor in focus is not changed

A wizard should appear with a list of projects and
traces to select. Next button should be disabled.

Next should be become enabled when the first trace is
zeleﬁeg. IF all traces are unselected, the Next button is
isabled.

Next should become disabled after Deselect All,
enabled after Select All.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to a
lower number.

All elements in the trace tree are unselected, the
Approximate uncompressed size field changes to 0. The
Next button is disabled.

When Select All is clicked, all the tree elements are
selected, the approximate size increases. When
Deselect All is clicked, all the tree elements are
deselected and the approximate size decreases.

A file chooser dialog comes up. Whe the destination file
is entered, the “To archive file" is filed witl
export.tar.gz. The Finish button should be enabled.

The name of the archive file changes to export.tar
The name of the archive file changes to export.zip

The name of the archive file changes to export.tar.gz

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
export.tar.gz file should be created on the file system.

The Archive file name should be remembered and
already filled. A dialog should prompt the user to
overwrite. Answering No should keep the wizard
opened. Answering Yes should re-export the archive
and close the wizard.

The export.zip file should be created on the file system

In both archives, verify that it contains:

1) A trace folder for each trace containing all the trace

files (excluding supplementary files)

%)l A .tracing folder containing all the supplementary
iles

3) An export-manifest.xml file listing the trace files,

supplementary files and bookmarks

Verify that the exported archive contains:

In both archives, verify that it contains:

1) A Traces folder containing all the trace files
(excluding supplementary files)

2) No .tracing folder

3) An export-manifest.xml file listing the trace files and
bookmarks

Does not work for ctf traces!

Fails for CTF traces (Bug 459672)



Create an empty tracin? project. Make sure you have
export.tar.gz available from the Trace Package Export Wizard
(13) test case, which should include everything includin

14.1  Preparation trace files, supplementary files and export-manifest.xml.
Open the trace package import  Click on “File”, “Import...", “Tracing”, “Trace Package Import” The first page of the wizard should appear (Choose
14.2  wizar and click Next content to import]
Click the Select button. Choose the previously created The Into project field gets filled with the selected
14.3  Project Selection project. project name.
Finish should be become enabled when the first trace is
1) Click on the Browse button. selected. If all traces are unselected, the Next button is
14.4  Archive file selection 2) Browse for export.tar.gz on the file system disabled.
With traces selected, press the Deselect All button. Then Finish should become disabled after Deselect All,
14.5 Deselect/Select All press on the Select All button. enabled after Select All.
14.6  Trace element selection Unselect the trace2 element All elements in the trace tree are unselected.
14.7  Trace sub-element selection Unselect the kernel_vm > Trace element All elements in the trace tree are unselected.

When Select All is clicked, all the tree elements are
With nothing selected, click Select All. Then click Deselect All. selected. When Deselect Allis clicked, all the tree
14.8  Select/Deselect All Then click Select All again. elements are deselected..

A progress bar should appear at the bottom the the
dialog and it should disappear upon completion. The
two traces should appear under the project in Project

14.9  Finish the wizard Click Finish Explorer
Delete Supplementary files appears in the content
14.10 Supplementary Files Right-click on trace2 in Project Explorer menu
14.11  Bookmarks Open the Bookmarks view Bookmarks appear in the list for the imported traces
The corresponding trace opens at the bookmarked
14.12  Open from bookmark Double click on one of the bookmarks event. Bookmarks are displayed in the event table.

A dialog should prompt the user to overwrite for each
Open the wizard again (step 13.2) and select the archive file trace. Answering Yes to All should overwrite without
14.13  Overwrite (step 13.4). Click Finish. prompting again.

15 Time Offsetting
Open Project Explorer view and Properties view. Create an

empty tracing project. Import two different traces to the
project. Open the traces and note their start time. Close the

151 Preparation traces.
The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - trace  Select both trace elements in the Project Explorer view. Trace name show both traces and the Offset in seconds
15.2  selection Right-click and select Apply Time Offset... is blank. SWTBot

The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - folder ~ Select the Traces folder element in the Project Explorer view. Trace name show both traces and the Offset in seconds

15.3  selection Right-click and select Apply Time Offset... is blank. SWTBot
Create an experiment with both traces. Select the The Apply time offset dialog opens in Basic mode. The
Apply time offset dialog - experiment element in the Project Explorer view. Right-click Trace name show both traces and the Offset in seconds
15.4  experiment selection and select Apply Time Offset... is blank. SWTBot

Select a trace element in the Project Explorer view. Right-
click and select Apply Time Offset... In the Offset in seconds  The timestamps in the trace are all offset by the

Apply time offset dialog - Basic  column, enter a time with seconds and decimals. Click OK. entered value. The Properties view shows the 'time
15.5 mode Open the trace. offset’ with the entered value. SWTBot
Select the same trace element in the Project Explorer view.  The timestamps in the trace are all offset by the
Right-click and select Apply Time Offset... In the Offset in cumulative sum of the previous and current entered
Apply time offset dialog - seconds column, enter a time with seconds and decimals. value. The Properties view shows the 'time offset' with
15.6  cumulative offset Click OK. Open the trace. the cumulative value. SWTBot

Select the trace element in the Project Explorer view. Right-  The timestamps in the trace are back to their original
click and select Clear time offset. Click OK to confirm. Open values. The Properties view shows the 'time offset' as
15.7  Clear time offset the trace. blank. SWTBot

The Apply time offset dialog opens and is switched to
Open one trace and close the other trace. Select both trace  Advanced mode. The Trace name show both traces and
Apply time offset dialog - elements in the Project Explorer view. Right-click and select the Offset in seconds is blank. The Reference time for
15.8  Advanced mode Apply Time Offset... Choose the Advanced radio button. the opened trace is set to its start time. Manual

Both traces are open. Selecting an event updates the
Reference time for the selected trace, and updates the
Target time for all traces. Pressing the button
computes the Offset in seconds as the difference
between Target time and Reference time for that row.
The trace which has a computed offset is closed when
Double-click the second trace to open it. Select an event in its the OK button is pressed. After reopening, the two

Apply time offset dialog - trace editor. Select the Ffirst trace editor. Select an event in its previously selected events now have the same
Advanced mode - compute from  trace editor. Click the button in the dialog row of the second timestamp. The Properties view shows the 'time offset'
15.9  selection trace. Click OK. Open both traces. with the computed value. Manual



15.10

15.11

Apply time offset dialog -
Advanced mode - compute from
entered values

Clear time offset with opened
traces

Select the first trace element in the Project Explorer view.
Right-click and select Apply Time Offset... Choose the

Advanced radio button. Double-click the trace name to open

it. Select the Reference time cell and copy the start time.

Select the Target time and paste the value. Edit both values
to different times. Click the button in the trace row. Click OK.

Open the trace.

Open both traces. Select both trace elements in the Project
Explorer view. Right-click and select Clear time offset. Click

OK to confirm. Open the traces.

The trace is opened. The Reference time is set to the
trace start time. The Reference time and Target time
can be copied, pasted, and edited. Pressing the button
computes the Offset based on the current time values.
The trace is closed with the OK button is pressed. After
reopening, the timestamps in the trace are offset
according to the computed value. The Properties view
shows the 'time offset’ with the computed value.

The opened traces are closed when the OK button is
pressed. After reopening, the timestamps in the traces
are back to their original values. The Properties view
shows the 'time offset' as blank.

Manual

Manual



Section Pass 11 ToDo Comment

TMF - BookmarksView 17 “ 1

Target: Ubuntu 14.10 64 bit

Step  Test Case Action Verification Comment
1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. Pass
2 Trace bookmarks
2.1 Show Bookmarks View Select Bookmarks view (bottom folder) Bookmaks view is shown Pass
Views are populated. Verify that a Kernel events editor is
22 Open trace Open an LTTng CTF Kernel trace opened showing LTTng Kernel specific columns Pass
Add a bookmark, by
a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct trace
2.3 Add Trace Bookmark Enter the bookmark description in dialog box resource) Pass No Edit menu in Trace Compass RCP

Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in

24 Open Trace Bookmark (1)  then double-click on bookmark in Bookmarks View event table Pass
Open another trace #2 and then double-click on bookmark in Make sure that correct trace #1 is brought to top and correct
2.5 Open Trace Bookmark (2)  Bookmarks view event with bookmark is selected in events table Pass
Close the trace #1 and then double-click on bookmark in Bookmarks Make sure that correct trace #1 is opened and correct event
2.6 Open Trace Bookmark (3)  view with bookmark is selected in events table Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Select bookmarks icon in event table right-click on icon and select ~ and corresponding bookmark is removed from the Bookmarks
2.7 table) "Remove Bookmark" view Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from and corresponding bookmark is removed from the Bookmarks
2.8 table) Double-clicking bookmarks icon in event table. view Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Add a bookmark (see 2.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
2.9 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. view Pass
3 Experiment bookmarks

Create Experiment with 2 LTTng CTF Kernel traces in it and open  Verify that an Events editor is opened showing LTTng Kernel
3.1 Create and open experiment experiment specific columns Pass

Add a bookmark, by

a) double-clicking on the left margin next to an event Make sure that bookmark icon is shown on left site of the
b) right-clicking the margin and select Add bookmark.... event row and is added to the Bookmarks view with relevant
¢) using the Edit > Add bookmark... menu. information (i.e. Description entered and correct experiment
32 Add Experiment Bookmark Enter the bookmark description in dialog box resource) Pass

Open Experiment Bookmark Scroll within event table so that bookmark is not visible anymore and Make sure that event with bookmark is selected and visible in

33 (1) then double-click on bookmark in Bookmarks View event table Pass
Open Experiment Bookmark Open another trace #2 and then double-click on bookmark in Make sure that correct experiment #1 is brought to top and
34 2) Bookmarks view correct event with bookmark is selected in events table Pass
Open Experiment Bookmark Close the experiment #1 and then double-click on bookmark in Make sure that correct experiment #1 is opened and correct
3.5 3) Bookmarks view event with bookmark is selected in events table Pass
Make sure that bookmark icon is removed from event table
Delete Bookmark (from Select bookmarks icon in Events view, right-click on icon and select and corresponding bookmark is removed from the Bookmarks
3.6 table) "Remove Bookmark" view Pass

Make sure that bookmark icon is removed from event table
Delete Bookmark (from Add a bookmark (see 6.4), then select bookmark in Bookmarks view, and corresponding Bookmark is removed from the Bookmarks
3.7 Bookmarks view) right mouse click and select "Delete". Confirm the deletion. view Pass



Section Pass Fail ToDo Comment

TMF - Filters View 12 [ o |1

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

Open a trace to be

1 filtered Trace is opened SWTBot Pass | Needs to be activated
2 Open filter view Filter view is opened SWTBot Pass
Create a filter on event  The filterview contains a filter on the event type and the
3 type and timestamp timestamp SWTBot Pass
3.1 Apply that filter A subset of the events pass SWTBot Pass

Create a filter on the
timestamp oring field

4 values Create the filter SWTBot Pass
4.1 Apply that filter A subset of the events pass SWTBot Pass
Create a filter with equals
5 node Create the filter SWTBot Pass
5.1 Apply that filter A subset of the events pass SWTBot Pass
Create a filter with
6 matches node Create the filter SWTBot Pass
6.1 Apply that filter A subset of the events pass SWTBot Pass
Create a filter with
7 contains node Create the filter SWTBot Pass

71 Apply that filter A subset of the events pass SWTBot Pass



Section Pass Fail ToDo Comment

TME - Colors View 6 | o o

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Open a test trace a trace is visible in the events editor SWTBot Pass

2 Open the colors view the view is visible SWTBot Pass
Select a color and a filter, the matching events should update

3 Select a color and a filter their colors (background and foreground) to the new ones SWTBot Pass

4 Add multiple colors Click on add 4 times, four colors should be displayed SWTBot Pass
Change the color By clicking on up and down, the order of the displayed colors

5 priorities should change SWTBot Pass

6 Delete all the colors The color filters should disappear. SWTBot Pass



Section Pass Fail ToDo Comment

TMF - Histogram View 50 n 3

Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment
1 Preparation
1.1 Step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views Pass
1.2 Step 2 Open an LTTng trace Views are populated Pass

2 Manage View

2.1 Close view Close the Histogram View Histogram View is removed from perspective Pass
2.2 Open view Window > Show View > Other > Tracing > Histogram Histogram View is displayed and re-populated Pass
2.3 Resize Resize the Histogram View width-wise Histograms are compressed/decompressed without loss Pass

3 Full Trace Histogram

3.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Pass
Select time range with shift-left-click, shift-left-drag or left-
3.2 Range selection drag Selection Start/End + blue bars are updated Pass
Drag the zoom window left/right with ctrl-left-drag or
33 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Pass
Zoom window is centered on click, won't go beyond full
3.4 Move zoom window Move the zoom window with ctrl-left-click or middle-click range Pass
Zoom window is set, Window Span is updated, won't go
3.5  Setzoom window Set a new zoom window with right-drag beyond histogram range Pass
Zoom window is updated, Window Span is updated,
3.6 Zoomin/out Zoom infout with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Pass
Selection (blue bar) moves to the previous/next non-
3.7  Arrow keys Move the current event using left/right arrow keys empty bucket Pass
3.8 Home/End keys Press Home/End key Selection Start/End moves to beginning/end of trace Pass | start time of last bucket is selected
With a trace containing lost events, click the "Hide lost
3.9 Lost events events" toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Pass
Zoom window is updated, Window Span is updated,
3.10  Zoom in/out (key) Zoom infout with +/- key won't go below 2 ns, won't exceed full trace range Pass
4 Time Range Histogram
4.1 Single selection Select timestamp with left-click Selection Start/End + blue bars are updated Pass
Select time range with shift-left-click, shift-left-drag or left-
4.2 Range selection drag Selection Start/End + blue bars are updated Pass
Drag the zoom window left/right with ctrl-left-drag or
4.3 Drag zoom window middle-drag Zoom window is dragged, won't go beyond full range Pass
Zoom window is updated, Window Span is updated,
4.4 Zoom infout Zoom infout with mouse wheel up/down won't go below 2 ns, won't exceed full trace range Pass
Selection (blue bar) moves to the previous/next non-
4.5 Arrow keys Move the current event using left/right arrow keys empty bucket Pass
Selection Start/End moves to beginning/end of time
4.6 Home/End keys Press Home/End key range Pass | start time of last bucket is selected
With a trace containing lost events, click the "Hide lost
4.7 Lost events events" toolbar icon. Click it again. The lost events (red bars) are toggled on and off. Pass
Zoom window is updated, Window Span is updated,
3.10 Zoom in/out (key) Zoom in/out with +/- key won't go below 2 ns, won't exceed full trace range Pass
5 Selection Start/End
5.1 Set selection start Enter a TS within the full range in Selection Start widget Selection Start + blue bars are updated Pass
5.2 Set selection end Enter a TS within the full range in Selection End widget Selection End + blue bars are updated Pass

Select the link icon. Enter a TS within the full range in
5.3 Set selection (linked) Selection Start widget Selection Start/End + blue bars are updated Pass



5.4
5.5

6.1
6.2

6.3

71

7.2

7.3

7.4

8.1

8.2

8.3

8.4

9.1

9.2

9.3

9.4

10

10.1

10.2

10.3

Set invalid selection start
Set invalid selection end

Window Span
Set window span
Set large window span

Set invalid window span

Selected Timestamp
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection synchronization
(linked)

External synchronization

Selected Time Range
Synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Selection Start/End
synchronization

External synchronization

Zoom Window
synchronization

Time Range mouse
synchronization

Full Trace mouse
synchronization

Window Span
synchronization

External synchronization

Multiple Trace
Synchronization

Preparation

Open multiple traces (no
overlap)

Change selected time and
range (no overlap)

Open multiple traces
(overlap)

Enter a TS before the full range start in Selection Start
widget

Enter a TS after the full range end in Selection End widget

Enter a span in Window Span widget
Enter an invalid span (too large) in Window Span widget

Enter an invalid span (too small, negative, not a number) in
Window Span widget

Click on the time range histogram. The time of the bucket at
the mouse position is selected.

Click on the Ffull trace histogram. The time of the bucket at
the mouse position is selected.

Select the link icon. Enter a time within the full range in
Selection Start widget

In any other view that supports time synchronization, select a

time.

Select a time range in the small histogram (shift-left click,
left-drag or shift-left drag).

Select a time range in the full histogram (shift-left click, left-
drag, shift-left drag).

Enter a time within the full range in Selection Start/End
widget

In any other view that supports time range synchronization,
select a time range.

Select a zoom window in the small histogram (ctrl-left drag,
middle-drag, right-drag, mouse wheel up/down).

Select a zoom window in the full histogram (ctrl-left drag,

middle-click, middle-drag, right-drag, mouse wheel up/down).

Enter a new span in Window Span widget

In any other view that supports range synchronization, select
a new zoom window.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time
Select a time and new range

Open multiple traces that overlap in time

Selection Start + blue bar set to first event
Selection End + blue bar set to last event

Both Histograms are updated accordingly
Span set to full range

Span set to previous value

Other views are synchronized to the selected time
Other views are synchronized to the selected time

Other views are synchronized to the selected time

Selection Start/End + blue bars in both histograms are
updated to the selected time

Verify that the selected time range shows in both
histograms, and in other views.

Verify that the selected time range shows in both
histograms, and in other views.

Other views are synchronized to the selected time range

Selection Start/End + blue bars in both histograms are
updated to the selected time range

Other views are synchronized to the new range
Other views are synchronized to the new range
Other views are synchronized to the new range

Window Span and both histograms are updated to the
new range

View shows the last opened trace

Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View shows the last opened trace

Pass
Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass



10.4

10.5

10.6
10.7

Change selected time and
range (overlap)

Select other trace
(overlap)

Trace coloring
Close all traces

Select a time and new range

Select different trace by clicking its editor tab

With an experiment containing multiple traces opened, click
the "Activate trace coloring" toolbar icon. Click it again.

Close all trace editor tabs

Selection Start/End, Window Span and both histograms
are updated to selected time and new range.

View is updated to show selected trace. Selection
Start/End, Window Span and both histograms are set to
the newly selected time and range.

The colors in both Histograms and toggled on and off.
When it is toggled off, the legend disappears at the
bottom and only one color is used for non-lost events.

View is cleared.



Section

TMF - Sequence Diagram

Target: Ubuntu 12.04 64 bit

Step

1

2.2

3.2

5

Test Case

Preparation

Open perspective

Open TMF Sequence
Diagram View

Create and open
experiment with
sequence diagram data

Manage View
Close view

Open view when
experiment/traces is
already loaded

Tooltip

Hover over interaction

Hover over interaction
after selection

Hover over time
compression bar

View Synchronization

Selection of interaction

Selection of event in
events table

Selection of new time
range

View Actions

Pass

Action

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}

2 )Use traces simple-server-thread1 and simple-server-

thread2 under traces/import/ for test cases below

Open and reset LTTng Kernel perspective

Use menu Window — Show View - Other ... - Tracing -
Sequence Diagram

1) Create Tracing Project
2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-

thread2

4) Select trace type "Generic CTF Trace"
5) Add these 2 traces to experiment

6) Open (double-click on) the experiment

Close Sequence Diagram view
1) Close 'Sequence Diagram' View

2) load sequence diagram experiment
3) Open Sequence Diagram view

1) Goto to first page (no selection of any interaction or

lifeline) 2) Hover over first interaction (arrow or number)

1) Goto to first page
2) select first interaction
3) Hover over 3rd interaction

Hover over first element in time compression bar on the left

of the view

Select an interaction in the 'Sequence Diagram'

Select an sequence diagram event in the events table (type

SEND or RECEIVE)

Change time range in 'Histogram View'.

Fail

Verification

LTTng Kernel perspective opens with correct views:
Project Explorer, Control, Control Flow, Resources,
Statistics, Histogram, Properties, Bookmarks

Verify that 'Sequence Diagram' view is shown

Verify that sequence diagram was loaded. The
interaction show the signal numbers (Note that trace
doesn't contain strings for the interactions. A special
parse)r would be necessary to map signal number to
trace

Sequence Diagram View is removed from perspective

Verify that sequence diagram was loaded. Verify that
all 17 pages are loaded.

Verify that tooltip appears with content with
interaction name and time stamp (10000
14:58:00.740995147)

Verify that tooltip appears with content with
interaction names and time stamp delta between
selected interaction and interaction that was hovered
over (10001 - 10000 delta: 000.000 157 023)

Verify that tooltip appears with delta and graph to
show where delta is in relation to current configured
min max values. (delta: 000.000 3 480)

Verify that interaction is highlighted in 'Sequence
Diagram' view. Verify that in the events table the
corresponding event is selected. Verify that time
stamps matches

Verify that corresponding interaction is selected in the
'Sequence Diagram' view

Verify that the focus to the corresponding events of
the 'Sequence diagram' changes is changed.

To Do

Comment

ICENE

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Tooltip backgound is very dark and text is hard to read
on Ubuntu 13.10, 14.10 with default theme
https://bugs.eclipse.org/bugs/show_bug.cgi?id=45552
3

It's a bit unclear to me what this is supposed to do. |
think it means when the start of the range changes, it
should update the events shown in the sequence
diagram



5.1

52

53

5.4

5.5

5.6

57

5.8

5.9

5.10

Test page navigation

Test menu item 'Pages...'

Find of interaction

Find of lifeline
Find criteria persistence

Find short-cut

Filter of interactions

Filter of lifelines

Deselect filter

Filter criteria persistence

Zoom-in

Selection after zooming

Zoom-out

Use buttons and menu items 'Go to next page', 'Go to
previous page', 'Go to last page' and 'Go to first page' to

navigate through trace. Use also menu item 'Pages...' to jump

to specific page

1) Select menu item 'Pages..."
2) In text box type “9"
3) Click on 'OK’

Goto to page 1 -

1) Use button and menu item “Find”

2) select Interactions and deselect lifeline
3) type regular expression 10.*00

4) press find

5) press find

6) press find

7) press find

8) press find

Goto to page 1~

1) Use button and menu item “Find”

2) select lifeline and deselect interaction
3) type player2

4) press find

5) press find

1) Restart eclipse
2) open find dialog

1) Select 'Sequence Diagram' view
2) pres CTRL+F

Goto to page 1 -~

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Interactions and deselect Lifeline
3.2) type regular expression 10.*03

4) Press 'Create’

5) Press 'Ok’

Goto to page 9 »

1) Use menu item 'Hide Patterns...'

2) Press Add

3.1) select Lifelines and deselect Interactions
3.2) type regular player2

4) Press 'Create’

5) Press 'Ok’

) Apply one Filter

) Use menu item 'Hide Patterns...'
) deselect filter

) click 'Ok’

1) Restart eclipse
2) open hide dialog

1
2
3
4

1) Use button and menu item for zoom-in to activate zooming

in
2) click into sequence diagram view

1) Click on button and menu item 'Select' to go back to
selection mode
2) select an interaction

1) Use button and menu item for zoom-out to activate
zooming out
2) click into sequence diagram view

Verify that different time ranges are selected when
changing page by looking at Histogram View.
Histogram View window will show the start of the
page. Note that there are 10000 interactions per page.
In this traces there are in total 160032 interactions.
?('o:erli.Fy that last page has 32 interactions between 2
ifelines.

Verify that a dialog box will show. Verify that for this
trace it shows 'Total: 17 pages is shown” and the
current page is displayed in the text box. After step 3)
verify that page where changed to page 9. For this
trace page 9 is the page with 3 lifelines.

After 4) verify that interaction 10000 (player1 -
master) is selected. After 5) verify that interaction
10100 (master - player1) is selected. After 6) verify
that 10000 (player2 - master) is selected. After 7)
verify that interaction 10100 (master — player2). After
8 nothing else will be found

After 4) verify that lifeline with name player2 is
selected (page 9 with 3 lifelines). After 5) player2 is
selected on page 10

Verify that previous used find criteria are still in the list

Verify that find dialog opens

After 5) verify that Interactions with name 10003 and
10103 are not shown

After 5) verify that player2 is not shown

Verify that all lifelines and interactions are shown
Verify that previous used hide criteria are still in the list

Verify that 'Sequence Diagram' view zooms in. Note
that no selection is possible.

Verify that selection is possible.

Verify that 'Sequence Diagram' view zoom out. Note
that no selection is possible.



5.15

5.22

5.24

Reset zoom

Configure min/max

Configure min/max
(default)

Show node end

Show node start

Show node end short-cut

1) Use button and menu item for 'Reset zoom factor' to reset Verify that 'Sequence Diagram' view goes back to

the zoom level

1) Select menu item 'Configure Min Max'

2) Change min to 100 and max to 2000 (keep scale and
precision)

3) press 'Ok’

After changing min and max
1) select menu 'Configure Min Max'
2) press 'Default’ 3) press 'Ok’

Goto to page 1~

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Use menu item Navigation - Show node end

Goto to page 1 -~

1) Resize view so that the beginning of the interactions are
not shown

2) select on interaction

3) Use menu item Navigation - Show node start

Goto to page 1 -~

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

3) Press SHIFT+ALT+END

Goto to page 1~

1) Resize view so that the arrow of the interaction is not
shown

2) select on interaction

Show node start short-cut 3) Press SHIFT+ALT+HOME

Scroll down short cut

Scroll up short cut

Overview feature

Print

Remove filter (Bug
391714)

Press SHIFT+ALT+ARROW_DOWN

Press SHIFT+ALT+ARROW_UP

Goto page 9 - Keep pressing + icon at the lowest right corner Verify that it's possible to navigate through a page of

of the view and drag down, up, left or right

Select 'Sequence Diagram' view and press printer icon in the
Eclipse's tool bar (or use CTRL+P). Select one pager page to
print

1) Create 1filter if necessary (see 5.8)

2) Open Error Log view if necessary

3) Open ﬁlter dialog box and remove all filters
4) Press 'Ok’

5) Open filter dialog box again

default zoom

After 1) verify that a dialog box shows with default
values. After 3) verify that time compression bar
changes some colors. It will show more deeper red
because the max value is lower.

After step 2) the default values are shown. After step
3) the time compression bar will change colors. Note
that the default values are computed based on all
deltas of 2 consecutive interactions.

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that end lifeline of the interaction (the arrow) is
shown

Verify that start lifeline of the interaction is shown

Verify that within a page the display scrolls down per
view size

Key combination on Ubuntu 12.04 is used for
something else. This can be disabled using the
combiz-settings-manager
(http://askubuntu.com/questions/171489/how-to-
unbind-shift-alt-up-shortkey-in-12-04)

After disabling this combination this test case
passes

Verify that within a page the display scrolls up per view

/ On Ubuntu 14.04, 14.10, this is not an issue, by
size

default the keys are not mapped.

On Ubuntu, the movement is hectic and the overview
box is very narrow.

On Mac OS X 10.8, the button is not visible but there is
a visible empty space that is clickable in its place.
Clicking on it brings up the overview box which has a
reasonable size but movement is still hectic.

the sequence diagram view Bug 436442

Verify that it is possible to print

Verify that no exceptions occurred and after 5) no filter
are listed



1) Open trace without any sequence diagram information
2) Open SD view if necessary
3) Open Error Log view if necessary

Time Sync. without 4) change time range in Histogram view
5.27  interactions (Bug 391716) 5) Change time current selected time in Histogram View Make sure that no exceptions occurred



Section
TMF - Statistics View

Target: Ubuntu 12.04 64 bit

Step

1

1.1

1.2

1.3

N

2.1

2.2

2.3

3.1

3.2

4.

4.2

5

5.1

5.2

Test Case

Preparation

Preparation
Open Perspective

Action

Download traces simple-server-thread1 and simple-
server-thread1 from traces/import/

Open and reset LTTng Kernel perspective
Use menu Window — Show View - Other ... - Tracing —»

Open TMF Statistics View Statistics

Open experiment

Manage View
Delete view

Open view

Open view when
experiment/trace is
already loaded

Other

Build of statistic index

Persistence of statistics

Range Synchronization

External synchronization
(Full)

External synchronization
(range)

Multiple Trace
Synchronization

Preparation

Open multiple traces (no

overlap)

1) Create Tracing Project
2) Create Experiment (SeqExp)

3) Import 2 traces simple-server-thread1 and simple-server-

thread2
4) Select trace type "Generic CTF Trace"
5) Add these 2 traces to experiment

Close the 'Statistics' View

Use menu Window — Show View — Other ... - Tracing -
Statistics

1) Close 'Statistics View' 2) load trace above trace 3) Open
'Statistics' view

Open trace

Open same trace multiple times after indexing of trace was

finished the first time

Verification

LTTng Kernel perspective opens with correct views

Verify that 'Statistics' view is shown

Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event

types
ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
are counted.

Statistics' view is removed from perspective

Statistics' view View is displayed and re-populated

Verify that statistics are shown per trace and per event
type. Each trace has 80021 events. Verify that event
types
ENTER/RETURN/SEND/RECEIVE/INFO/after_fork_child
are counted

Verify that 'Statistics' view is populated when indexing
is finished

Verify that when opening the trace the x-times (x > 1),
that the statistics appear right away without parsing
the trace again

In any other view that supports range synchronization, select Events in selected time range' is updated and equals

the full range of the trace.

'Events total' values

In any other view that supports range synchronization, select Events in selected time range' is updated according to

anew range.

1) Download traces.zip (if necessary) and unzip into a local

directory ${local}
2) Import kernel trace ${local}/traces/import/kernel-
overlap-testing

3) Import UST ${local}/traces/import/trace ust-overlap-

testing
4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in time

new range

View shows the last opened trace

Change selected time and In any other view that supports range synchronization, select Events in selected time range' is updated according to

range (no overlap)

anew range

new range

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

To Do

Comment

Comment

Randomly, the number of events in a trace stays at zero
when the statistics view is opened. However, | can't
reproduce the problem at will. Bug 436416

Bug 459571

Bug 459571



53

54

55

5.6
5.7

Select other trace (no
overlap)

Open multiple traces
(overlap)

Change selected time and In any other view that supports range synchronization, select

range (overlap)

Select other trace
(overlap)

Close all traces

Select different trace by clicking its Events editor tab
Open multiple traces that overlap in time

anew range

Select different trace by clicking its Events editor tab
Close all Events editor tabs

View is updated to show selected trace. 'Events in
selected time range' is updated according to the
selected trace's previously selected range.

View shows the last opened trace

Events in selected time range' is updated according to
new range

View is updated to show selected trace. 'Events in
selected time range' is updated according to the newly
selected time and range.

View is cleared.



Section Pass Fail ToDo Comment
TMF - Time Chart View 25 | o |2
Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Preparation
1.1 Preparation step 1 Open and reset LTTng Kernel perspective LTTng Kernel perspective opens with correct views. Pass
1.2 Preparation step 2 Show Time Chart View Time Chart view is shown Pass

2 Trace handling
Trace #1 entry added to Time Chart view. Trace #1 is
2.1 Open trace Open an LTTng CTF Kernel trace #1 selected entry. Range of view is full trace range. Pass

Trace #2 entry added to Time Chart view. Trace #2 is
selected entry. Range of view is union of full trace
2.2 Open other trace Open an LTTng CTF Kernel trace #2 ranges. Pass

Experiment entry added to Time Chart view.
Experiment is selected entry. Range of view is union of

2.3 Open experiment Open an experiment full trace ranges. Pass
Trace #1is selected entry. View range does not change.
2.4 Select other trace Select trace #1 by clicking its trace entry in Time Chart view  Trace #1 editor tab is brought to top. Pass
Select other trace
2.5 (external) Select trace #2 by clicking its editor tab Trace #2 is selected entry. View range does not change.|  Pass
2.6  Close view Close the Time Chart view Time Chart view is removed from perspective Pass
Time Chart view is displayed and re-populated with
2.7 Open view Show Time Chart view opened traces data Pass
Trace entry is removed from Time Chart view. Range is
2.8 Close trace/experiment  Close trace #2 editor tab. Repeat with experiment editor tab. view is union of remaining full trace ranges. Pass
2.9  Close last trace Close trace #1 editor tab View is cleared. Pass
3 Time Synchronization
Other views are synchronized to the selected time.
Mouse synchronization Event at or following the selected time is selected in
3.1 (single time) Left-click on the time chart. The selected time line is updated. the event table. Pass
Other views are synchronized to the selected range.
Mouse synchronization  Shift-left-click or left-drag on the time chart. The selected Event at or following the selected time is selected in
3.2 (time range) time range is updated. the event table. Pass
External synchronization Selected time line is updated to the event time. If
3.3 (single time) In event table, select an event. necessary, range is updated to show selected time. Pass
External synchronization
3.4 (time range) In event table, select an event range with shift-left-click. Selected time line is updated to the time range. Pass
Zoom Range

4 Synchronization
Mouse wheel

4.1 synchronization Zoom infout with mouse wheel while holding Ctrl. Other views are synchronized to the new range Pass
Mouse drag zoom

4.2 synchronization Drag zoom with right-button on time chart. Other views are synchronized to the new range Pass
Mouse drag move

4.3 synchronization Drag move with ctrl-left or middle button on time chart. Other views are synchronized to the new range Pass
Mouse full range

4.4 synchronization Double-click with left button on time chart's time scale. Other views are synchronized to the full range Pass

In any other view that supports range synchronization, select

4.5 External synchronization anew zoom range. View range is updated to the new range Pass

Event Table
5 Synchronization

5.1 Search synchronization  Enter a search regex in event table Matching events are marked in time chart Pass  Bug 436324: Text is not seen as is it typed into the text field on GTK3

5.2  Search cleared Clear the search regex in event table Marks are removed in time chart Pass

53 Filter synchronization Enter a filter regex in event table Non-matching events are removed from time chart Pass

5.4 Filter cleared Clear the filter regex in event table All events are shown in time chart Pass
Bookmark

5.5  synchronization Add a bookmark in event table Bookmarked event is marked in time chart Pass

5.6 Bookmark cleared Remove the bookmark in event table Mark is removed in time chart - Bug 436323: Bookmark is not removed right away, only when the view is refreshed. This bug used to be GTK3 only but is reproducible with GTK 2.24.25 on Ubuntu 14.10



Section F13
TMF - Custom Parsers 27

Target: Ubuntu 14.10 64 bit

Step Test Case Action
0 Prerequisites
0.1  Get custom parser definition and logs Find text and XML test files.
1 View management
Open and reset Tracing perspective, and
1.1 Open perspective open Time Chart view
Create a tracing project and import a text
1.2 Import traces and XML custom trace
2 Custom parser management
Open Manage Custom Parsers dialog in
2.1 Open Manage Custom Parsers dialog Traces folder context menu
Select "Text" radio button, click New...
button, enter Log Type, change stuff,
2.2 New (text) click Next, click Finish
Select custom parser, click Edit...,
2.3 Edit (text) change stuff, click Next, click Finish
Select custom parser, click Export, enter
2.4  Export (text) name, click Save
2.5 Delete (text) Select custom parser, click Delete
Click Import, find custom parser
2.6 Import (text) definition, click Open
Select "XML" radio button, click New...
button, enter Log Type, change stuff,
2.7 New (XML) click Next, click Finish
Select custom parser, click Edit...,
2.8 Edit (XML) change stuff, click Next, click Finish
Select custom parser, click Export, enter
2.9  Export (XML) name, click Save
2.10 Delete (XML) Select custom parser, click Delete
Click Import, find custom parser
211 Import (XML) definition, click Open
3 Custom parser trace handling
Select test file in Traces folder, right-click,
select "Select Trace Type > Custom Text
3.1 Select trace type (text) > (parser name)"
3.2  Open trace (text) Double-click on test file in Traces folder
3.3 Raw view (text) Right-click in editor, click Show Raw
Click in Time Chart view, select event in
3.4  Time synchronization (text) editor table, select event in raw view

Fail

Verification

Time Chart view opens.

Traces imported in Traces folder of project.

Dialog opens.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Imported custom parser appears in list.

Custom parser appears in list.

Previously entered data appears, can be
edited.

Exported custom parser stored in file system.
Custom parser is deleted.

Imported custom parser appears in list.

Trace type is assigned (re-open Select Trace
Type sub-menu to verify)

Editor opens with events table, Time Chart
view is populated.

Editor is split with raw view on right pane.

All three widgets synchronize to selected
time.

To Do

Comment

| o ]

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass
Pass

Pass

Comment



3.5

3.6
37

3.8

41

4.2

43

44

45

46

Select trace type (XML)

Open trace (XML)
Raw view (XML)

Time synchronization (XML)

Raw viewer

Show Raw Viewer
Hide Table

Show Table
Select Event (Bug 457852)
Select Event using arrow keys

(457852)

Hide Raw viewer

Select test file in Traces folder, right-click,
select "Select Trace Type > Custom XML Trace type is assigned (re-open Select Trace
> (parser name)" Type sub-menu to verify)

Editor opens with events table, Time Chart
Double-click on test file in Traces folder view is populated.

Right-click in editor, click Show Raw Editor is split with raw view on right pane.
Click in Time Chart view, select eventin All three widgets synchronize to selected
editor table, select event in raw view time.

1) Open Custom text trace
2) Right-click in table and select "Show

Raw" Raw viewer is shown beside the events table
Right-click in table and select "Hide Events table is hidden and only raw viewer is
Table" shown

Right-click in table and select "Show

Table" Events table is shown beside raw viewer

Correct event is select in table, timestamp is

propagated to other TMF views and

Properties view shows content of selected
Select event in raw viewer event

Correct event is select in table, timestamp is
1) select event in raw viewer with mouse propagated to other TMF views and
2) use arrow key down and up several Properties view shows content of selected
times event

Raw viewer is hidden and only events table
Right-click in table and select "Hide Raw" is shown




Target:

2.1

22

2.3

2.4

2.5

2.7
2.6

2.7

3.1

32

4.1

42

Section
TMF - State System Explorer
Ubuntu 14.04 64 bit

Test Case

Preparation
Open TMF State System Explorer
View

Manage View

Delete view

Open view

Open Trace

Open view when trace is already
loaded

Open Experiment

Select other trace
Restart

Close all traces

Timestamp / Time Range
Selection

Select timestamp

Select time range

Displaying of Changed Values

Highlighting of changed values
“Only Display Changes at Selected
Timestamp” option with event
selection

“Only Display Changes...” with
timestamp selection

Action

Use menu Window — Show View — Other ... — Tracing —

State System Explorer

Close the State System Explorer' View

Use menu Window — Show View — Other ...
State System Explorer

— Tracing —

Open an LTTng Kernel Trace

1) Close State System Explorer View
2) Load LTTng trace
3) Open 'State System Explorer' view

Open Experiment with 2 or more LTTng traces

Select different trace by clicking its Events editor tab
Restart Eclipse

Close traces and experiment one by one from the editor tab

Select time in another view (e.g Histogram view) that supports
time synchronization

Select a time range in another view that supports time
synchronization

Select many different timestamps one after the other

Enable the “Only Display Changes...” option with the toolbar
button. Select different Events from the Event Table.

Enable the “Only Display Changes...” option. Select
*timestamps* corresponding to state changes (for example,
using the previous/next buttons in the Control Flow View).

Verification

Verify that 'State System Explorer' view is shown

'State System Explorer' view is removed from perspective

'State System Explorer' view is displayed and re-populated

Verify that view is populated with kernel state system
(o.c.t.analysis.os.linux.kernel) and statistics state systems (o.e.l.tmf.statistics.*)
of opened trace

Verify that view is populated with state systems from trace

Verify that view is populated with all kernel state system and statistics state
systems of opened experiment (separated by trace)

View is updated to show selected trace. State values, start time and end time are

updated according to the selected trace's previously selected range.

Verify that view is populated with state systems from trace

Verify that state system explorer view is cleared after closing the last trace

Verify that state values are updated

Verify that only the start of the range is taken in consideration (changing the
end time of the range should not affect the displayed values)

Attributes whose value changed in the last timestamp selection should be
highlighted in yellow.

Verify that only the state values that changed because of that event are
displayed.

Verify that only the state values that changed at that timestamp are displayed.

To Do Comment

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Some state systems ID's should be renamed for Trace Compass

(if the state system were already built)

The values are only available for time ranges where the trace
exists. Only after we've "visited" other timestamps, then the

attributes show up and print "Out of range".
http://eclip.se/443653



Target:

Section
TMF - Call Stack View
Ubuntu 14.10 64 bit

To Do Comment

1.3
1.4

2.1

22
2.3

2.4

2.5
2.7
2.6

2.7

3.1

3.2
33
3.4

4.1

42
43

5.1

5.2

Test Case

Download the test resources

Preparation
Open TMF Call Stack View

Import generic trace

Import cyg-profile trace
Import cyg-profile-fast trace

Manage View

Delete view

Open view

Open Trace

Open view when trace is already loaded

Open Experiment
Select other trace

Restart

Close all traces

Navigation

Select time

Select Previous/Next Event
Zoom to function (table)

Zoom to function (time graph)

Synchronization

Time synchronization

Event synchronization

Time range synchronization

Function name import - Text file

Invalid text file import

Valid text file import

Download this

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Verification

Verify that 'Call Stack' view is shown

Import a trace that does not have any call stack information, like Verify that nothing is shown in the view, except “Stack info not available

a standard kernel trace

Import the trace in the "trace" directory of the downloaded zip

(<tracename>)"

Verify that the Callstack View is populated with some callstack information.

Import a trace in the "trace-fast" directory of the downloaded zip Verify that the Callstack View is populated with some callstack information.

Close the Call stack view' View

Use menu Window — Show View — Other ... — Tracing —
Call Stack

Open "trace(-fast)" trace

1) Close 'Call Stack' view

2) Open "glxgears-cyg-profile(-fast)" trace
3) Open 'Call Stack' view

Open Experiment with 2 or more Call Stack traces.
(You can use both traces)

Select different trace by clicking its Events editor tab
Restart Eclipse with Call Stack trace opened

Close traces and experiment one by one from the editor tab

Click on random time in the time graph pane

Click Previous/Next Event button
Double-click on a function in the table pane

Double-click on a function (interval) in the time graph pane

Select a random time in another view

Select a call stack-impacting event (function entry/exit) in events

table

Select a new time range in Histogram view.

Click the "Import a textfile..." button in the view. Select a
random file that does not contain any debugging info.

Import a file "fibonacci.symbols"

'Call Stack' view is removed from perspective

'Call Stack' view is displayed and re-populated
Verify that view is populated with call stack information

Verify that view is populated with call stack information

Verify that view is populated with all call stack information (separated by
trace).

View is updated to show selected trace.

Verify that view is populated with call stack from trace

Verify that Call Stack view is cleared after closing the last trace

Selected time line is updated. Table is updated to show the full stack
information at the selected time. Selected time is updated in other views.

Previous or next call stack change is selected and corresponding active function
and stack depth is selected. Table is updated to show the full stack information
at the selected time. Selected time is updated in other views.

Time range is updated to the full duration of the selected function

Time range is updated to the full duration of the selected function

Selected time line is updated. Table is updated to show the full stack
information at the selected time. If selected time is outside current range, time
range is updated to include it.

In addition to updating the selected time, the active function at the event time is
selected. Vertical scroll bar is updated if necessary.

Time range is updated.

The function addresses do not change.

The view now displays function names instead of function addresses (both in
the timegraph and the call stack areas).

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass
Pass

Pass

Pass

Comment

The symbol mapping is applied on view level. If multiple traces
are opened, or if an experiment with multiple traces is opened,
they cannot each have their own mapping. Bug 459909.


https://drive.google.com/file/d/0BxUCnNTRLr5pWUdXd0JJV3hyeEk/edit?usp=sharing

Click the "Import Binary..." button in the view, select the
Binary import fibonacci executable (fibonacci) The view now displays the function names for both traces




Target:

Step

0

1.2
1.3

Section
LTTng 2.0 - Control Flow View

Test Case

Prerequisites
Import traces

Create experiment

View management
Open perspective

Open trace

Open experiment
Close view

Open view
View selection
Select process in table

Select process in time graph

Select state in time graph
Mouse handling

Drag move time range

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Pass

Action

Import LTTng Kernel traces in Tracing
project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective

Fail

Verification

Control Flow view opens.

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.

Open LTTng Kernel trace in Project Explorer Arrows are drawn between states of a CPU.

Open experiment with LTTng Kernel traces
in Project Explorer

Close the Control Flow view

Open the Control Flow view

Select a process in the table

Select a process in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down,

Control Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.
Arrows are drawn between states of a CPU.

View is closed.

Control Flow view is opened and populated
with processes.

Same process is highlighted in time graph.

Same process is highlighted in table.
Selected time line is updated. Other views
are synchronized to selected time.

Same process is highlighted in table. State is
highlighted in time graph. Selected time line
is updated. Other views are synchronized to
selected time.

Time range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped

cursor inside time graph while holding the Ctl for a short time, states are updated and new

button

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down,
cursor outside time graph

time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Table and time graph scroll up and down and
remain aligned. Selected process does not
change. Vertical scroll bar updated.

To Do

Comment

| o o

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



3.5

3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

4.3

44

5.1

5.2

5.3

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse selection

Shift key selection
Keyboard handling

Keyboard navigation in table
(process selection)

Keyboard navigation in table (tree
expansion)

Keyboard navigation in time graph
(process selection)

Keyboard navigation in time graph
(state selection)
Tool bar handling

Show Legend

Reset Time Scale

Select Previous/Next Event

Table and time graph scroll up and down and
remain aligned. Selected process does not
Click and drag vertical scroll bar change.

Selection highlighted. When mouse button is

released, time range is zoomed to selection,

states are updated and new time range is
Drag select time graph with right button propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to

Double-click left button on time scale other views.
Hover mouse in time graph over empty
region Tool tip shows process name only.

Tool tip shows process name, state name,

date, start time, end time, duration. For

USERMODE state, CPU is shown. For

SYSCALL state, CPU and System Call is

shown. For INTERRUPTED state, CPU is
Hover mouse in time graph over state shown.

Selection highlighted. Status bar of Eclipse is

updated with time information: T, T1, T2 and

delta, where T is the time of the mouse

position, T1 the left most selected time, T2

the right most selected time and delta the
Drag select time graph with left button time difference between T2-T1

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse

Click select with left button (begin time), position, T1 the left most selected time, T2
press shift key and click select another time the right most selected time and delta the
(end time) time difference between T2-T1

Selected process is changed. Time graph
With focus on table, use UP, DOWN, HOME, selection is updated. Vertical scroll bar

END keys updated.

With focus on table, For parent process, tree is expanded or

in Windows use LEFT, RIGHT keys while collapsed. Time graph item expansion is
parent or child process is selected updated. Vertical scroll bar updated. For child

process, left changes selection to parent,
in Linux use SHIFT LEFT, RIGHT keys while time graph selection is updated. Vertical
parent or child process is selected scroll bar updated.

With focus on time graph, use UP, DOWN, Selected process is changed. Table selection
HOME, END keys is updated. Vertical scroll bar updated.

With focus on time graph, use LEFT, RIGHT Previous or next state is selected. Selected
keys time is updated in other views.

The legend dialog is opened and can be
Click Show Legend button closed.

Time range is reset to full range, states are
updated and new time range is propagated to
Click Reset Time Scale button other views.

Previous or next state is selected. Selected
Click Previous/Next Event button time is updated in other views.




Selected process is changed in table and
5.4 Select Previous/Next Process Click Previous/Next Process button time graph. Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of time range. States are updated and

5.5 Zoom In/Out Click Zoom In/QOut button new time range is propagated to other views.
5.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly
1) Open Filter Dialog
2) Deselect several processes Verify that only selected processes are
5.7 Filter Processes 3) Press Ok displayed in the view

Verify that arrows are not drawn in the time
5.8 Hide Arrows Click Hide Arrows button graph

Time graph is updated to show the next state
With focus on time graph, click Follow CPU for this cpu following the arrow, the event is
5.9 Follow CPU Forward Forward button selected in the Events editor.

Time graph is updated to show the previous
With focus on time graph, click Follow CPU  state for this cpu following the arrow, the
5.10 Follow CPU Backward Backward button event is selected in the Events editor.

6 Synchronization

Selected time line is updated. If selected time
is outside current range, time range is

6.1 Time synchronization Select a random time in another view updated to include it.
Select a state-impacting event In addition to updating the selected time, the
(sched_switch, syscall, ...) in events table or process containing the state change is
in Resources view using Select selected. Vertical scroll bar is updated if
6.2 Event synchronization Previous/Next event. necessary.
Select a new time range in Resources view
6.3 Time range synchronization or in Histogram view. Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
Time range selection In any other view that supports range range, then time range is updated to include
6.4 synchronisation synchronization, select a new range. it

7 Multiple Trace Synchronization

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST
${local}/traces/import/trace ust-overlap-

testing
Preparation 4) Create experiment with trace of 2) in it
Open multiple traces that don't overlap in
7.1 Open multiple traces (no overlap) time View shows the last opened trace
Change selected time and range Selected time line and time range is updated
7.2 (no overlap) Select a time and new range to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are
Select different trace by clicking its Events restored to the selected trace's previously

7.3 Select other trace (no overlap) editor tab selected time and range.
7.4 Open multiple traces (overlap)  Open multiple traces that overlap intime  View shows the last opened trace
Change selected time and range Selected time line and time range is updated

7.5 (overlap) Select a time and new range to selected time and new range.



View is updated to show selected trace.
Select different trace by clicking its Events Selected time line and time range are set to
7.6 Select other trace (overlap) editor tab the newly selected time and range.

7.7 Close all traces Close all Events editor tabs View is cleared.

1) Open LTTng Kernel Trace
2) Select Control Flow View
8.1 Restart (Bug 409345) 3) Restart Eclipse Verify that Control Flow View is populated




Section
LTTng 2.0 - Resources View

Target: Ubuntu 14.04

Step

0

1.2
1.3

Test Case

Prerequisites
Import traces

Create experiment

View management

Open perspective

Open trace

Open experiment
Close view

Open view
View selection

Select resource in time graph

Select state in time graph
Mouse handling

Drag move time range

Zoom time range (mouse wheel)

Zoom time range (mouse drag)

Mouse vertical scroll

Vertical scroll bar

Pass

Action

Import LTTng Kernel traces in Tracing
project

Create an experiment with LTTng Kernel
traces

Open and reset LTTng Kernel Perspective,
and select Resources view

Open LTTng Kernel trace in Project Explorer

Open experiment with LTTng Kernel traces
in Project Explorer
Close the Resources view

Open the Resources view

Select a resource in the time graph (empty
region)

Select a state in the time graph

Ctrl-Drag move time graph left and right with
middle button

Zoom with mouse wheel up and down,
cursor inside time graph

Drag in time graph scale left and right with
left button

Scroll with mouse wheel up and down,
cursor outside time graph (in name space)

Click and drag vertical scroll bar

Fail

Verification

Resource view opens.

Resources Flow view is populated with
processes, sorted by Trace then TID. Child
processes appear under their parent, sorted
by birth time. Range is set to initial offset.

Resource view is populated with traces
(sorted by name) and their resources as tree
children (sorted by resource type then
numerically) Range is set to initial offset.

View is closed.

Resources view is opened and populated
with processes.

Resource is highlighted. Selected time line is
updated. Other views are synchronized to
selected time.

State is highlighted in time graph. Selected
time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button
is released, states are updated and new time
range is propagated to other views.

Time range is zoomed in and out, relative to
mouse cursor. When mouse wheel is stopped
for a short time, states are updated and new
time range is propagated to other views.

Time range is zoomed in and out. When
mouse button is released, states are updated
and new time range is propagated to other
views.

Time graph scrolls up and down. Selected
process does not change. Vertical scroll bar
updated.

Time graph scroll up and down and remain
aligned. Selected process does not change.

To Do

Comment

| o o

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment



3.6

3.7

3.8

3.9

3.10

3.1

4.1

4.2

5.1

5.2

5.3

5.4

5.5

6.1

6.2

6.3

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shit key selection
Keyboard handling

Keyboard navigation in time graph

(process selection)

Keyboard navigation in time graph

(state selection)
Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out
Synchronization

Time synchronization

Time range synchronization

Time range selection
synchronisation

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty
region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time),
press shift key and click select another time
(end time)

With focus on time graph, use UP, DOWN,
HOME, END keys

With focus on time graph, use LEFT, RIGHT
keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button

Select a random time in another view

Select a new time range in Control Flow
view or in Histogram view.

In any other view that supports range
synchronization, select a new range.

Selection highlighted. When mouse button is
released, time range is zoomed to selection,
states are updated and new time range is
propagated to other views.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Tool tip shows resource name only.

Tool tip shows resource name, state name,
date, start time, end time, duration. For IRQ
state, IRQ number is shown. For
IRQ_ACTIVE/SOFT_IRQ_ACTIVE state,
CPU is shown.

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selection highlighted. Status bar of Eclipse is
updated with time information: T, T1, T2 and
delta, where T is the time of the mouse
position, T1 the left most selected time, T2
the right most selected time and delta the
time difference between T2-T1

Selected process is changed. Vertical scroll
bar updated.

Previous or next state is selected. Selected
time is updated in other views.

The legend dialog is opened and can be
closed.

Time range is reset to full range, states are
updated and new time range is propagated to
other views.

Previous or next state is selected. Selected
time is updated in other views.

Selected process is changed in time graph.
Vertical scroll bar updated.

Time range is zoomed in and out, relative to
center of time range. States are updated and
new time range is propagated to other views.

Selected time line is updated. If selected time
is outside current range, time range is
updated to include it.

Time range is updated.

Selection is highlighted. If begin time (T1) of
selected time range is outside the current
range, then time range is updated to include
it



7.1

7.2

7.3
7.4

7.5

7.6
7.7

8.1

Multiple Trace Synchronization

Preparation

Open multiple traces (no overlap)

Change selected time and range
(no overlap)

Select other trace (no overlap)
Open multiple traces (overlap)

Change selected time and range
(overlap)

Select other trace (overlap)
Close all traces

Miscellaneous

Restart (Bug 409345)

1) Download traces.zip (if necessary) and
unzip into a local directory ${local}

2) Import kernel trace
${local}/traces/import/kernel-overlap-
testing

3) Import UST
${local}/traces/import/trace ust-overlap-
testing

4) Create experiment with trace of 2) in it

Open multiple traces that don't overlap in
time

Select a time and new range

Select different trace by clicking its Events
editor tab

Open multiple traces that overlap in time

Select a time and new range

Select different trace by clicking its Events
editor tab

Close all Events editor tabs

1) Open LTTng Kernel Trace
2) Select Resource View
3) Restart Eclipse

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are
restored to the selected trace's previously
selected time and range.

View shows the last opened trace

Selected time line and time range is updated
to selected time and new range.

View is updated to show selected trace.
Selected time line and time range are set to
the newly selected time and range.

View is cleared.

Verify that Resources View is populated




Section
LTTng 2.0 - Control View

Target: Ubuntu 12.04 64 bit

Step

0

LTTng Tools 2.5.4, Built-in SSH
Test Case

Prerequisites

Set Proxy
General
Open perspective

Manage View
Close view

Open Control view

Connection Handling

Create Host Connection

Disconnect

Connect

Select Host Connection

Node contexts sensitive
menu (host connected)

View button enable state
(host connected)

Node contexts sensitive
menu (host disconnected)

Pass
104

Action

For the tests below a Ubuntu machine with LTTng 2.0 installed

(with Ittng tools 2.0.x) is required. Either create a machine
yourself or use machine vCloud machine 142.133.166.54.

Fail

Verification

Make sure that the root session daemon is running (sudo Ittng LTTng Tracer Control User Guide:
list -k) and have one UST process running (e.g. from Ittng-tools hifp:7/wiki-eclipse.org/Linux_Tools_Project/LTTng2/User

git repository under tests/hello.cxx)

a) Window — Preferences — General — Network Connections

b) Set “Active Provider” to “Direct”

Open and reset LTTng Kernel Perspective

Close Control View

Use menu Window — Show View — Other ... — Lttng —
Control

1) Click Button 'New Connection..."
2) Select Tree item "Built-in SSH" and click on Create

3) Enter Connection Name (e.g. MyHost), enter Host Name (a

DNS name or IP address), username and password
4) Click 'Finish'

In Tree select the newly create connection and click on 'Ok’

5)
a) Select host to disconnect and click Button 'Disconnect’
b) Redo test with context sensitive menu item 'Disconnect'

a) Select host to connect and click Button 'Connect'
b) Redo test with context sensitive menu item 'Connect'

1) Restart Eclipse

2) Click Button 'New Connection...!

3) Select the host previously created

4) Select 'OK'. (Afterwards enter user ID and Password if
necessary)

1) Connect to remote host
2) select connected node and click right mouse button

1) Connect to remote host (if necessary)
2) select connected node

1) Disconnect from node
2) select disconnnected node and click right mouse button

_Guide#LTTng_Tracer_Control

LTTng Kernel perspective opens with correct Control
view on the left bottom corner

Control view is removed from perspective

Verify that Control view is shown

Make sure that after 4) the new connection is shown in
the tree. Verify that the new host is shown in the Control
view (with 'Connection Name'. After Ssh connection has
been established, make sure that Provider and Session
nodes are created in the Control view underneath the
host. Verify that all active Providers (Kernel and UST
providers) are shown under the 'Provider' node.

Verify that icon for the corresponding node changes to
the disconnect icon and all sub-nodes are removed.

Verify that icon for the corresponding node changes to
the connected icon and after successful SSH connection
all data is retrieved form the remote host (Providers,
sessions etc).

Make sure that SSH connection is established and all
data is retrieved from the remote host ( (Providers,
sessions etc).

Verify that menu items are shown and enabled/disabled
depending on state:

'‘Connect’ (disabled)

Disconnect (enabled)

Refresh (enabled)

Delete (disabled)

Verify enable state of view buttons:
'New Connection..." (enabled)
'Connect’ (disabled)
‘Disconnect' (enabled)
'Refresh’ (enabled)

'Delete’ (disabled)

‘Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that menu items are shown and enabled/disabled
depending on state:

'Connect’ (enabled)

'‘Disconnect’ (disabled)

'Refresh’ (disabled)

'Delete’ (enabled)

To Do

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment
19

Comment

LTTng 2.6

pass

pass

pass

you must remove the focus on the view then re-enable it to create a connection

pass

pass

pass

pass

pass

pass


LTTng_Tracer_Control
LTTng_Tracer_Control
LTTng_Tracer_Control

3.8

3.9

3.10

4.1

4.2

4.3

44

4.5

4.6

4.7

4.8

4.9

4.10

View button enable state
(host connected)

Delete

Create Host Connection
with ssh port

Session Handling
Preparation

Sessions Context
Sensitive Menu

Create Session (default
location)

Create Session (custom
location)

Create Session — session
already exists in GUI

Create Session — session
already exists on node

Session Context Sensitive

menu (session inactive)

View button enable state
(session inactive)

Start Session

Session Context Sensitive

menu (session active)

1) Disconnect to remote host (if necessary)
2) select disconnected node if necessary

a) Select node to delete (state disconnected) and click on
button 'Delete’

b) Redo test with context sensitive menu item 'Delete’

c) Redo the test with the Local host from RSE

re-do 3.1 but this time specify a port number other than default
SSH port 22

1) Connect to remote host

Select 'Sessions' in tree and click right mouse button

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu

3) Enter session name 'MySession', keep 'Session Path' empty

4) Select 'Ok’

1) Click right mouse button on 'Sessions'

2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MyOtherSession'

4) enter custom path (/tmp/myTraces) for 'Session Path’
5) Select 'Ok’

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu

Verify enable state of view buttons:
‘New Connection..." (enabled)
'Connect’ (enabled)
‘Disconnect’ (disabled)
'Refresh’ (disabled)

'Delete’ (enabled)

‘Start' (disabled)

'Stop' (disabled)

'Destroy Session..." (disabled)
'Record Snapshot' (disabled)
‘Import..." (disabled)

Verify that host is removed from the control view. Verify
that host doesn't show up in available hosts when
creating a new connection (see 3.4), for c) the Local host|
won't be removed

The connection should fail (unless remote is configured
for the specified port)

Verify that menu items are shown and enabled:
'Refresh’, 'Create Session...", 'Execute Command Script

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Session Path’ (=/home/<user>/traces/MySession_<date
and time>) and 'State' (<INACTIVE)

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MyOtherSession)

'Session Path' (=/tmp/myTraces) and 'State'
(=INACTIVE)

Make sure that an error message appears in the
message area of the dialog box with information that

3) Enter session name 'MySession', keep 'Session Path' empty session 'MySession' already exists in the tree.

1) login to the remote host using a command shell

2) type Ittng create newSession and press enter. This will
create a session which is not know by the Control view.
3) Click right mouse button on 'Sessions'

4) Select 'Create Session..." in the context sensitive menu

5) Enter session name 'MySession', keep 'Session Path' empty exists on the node. Select 'Detail

6) Select 'Ok’

Select newly created session and click right mouse button

Select newly created session (enable an event before)
a) Eable an event

b) Select session and click on button 'Start'
c) Redo test with context sensitive menu item 'Start'

Select started session and click right mouse button

Verify that an error dialog box will show with information
that command to create a session failed. session already]
Verify that the

command error detail is shown (with return value (28))

Verify context sensitive menu items:
‘Refresh’ (enabled)

'Start’ (enabled)

'Stop' (disabled)

'Destroy Session...' (enabled)

‘Import..." (enabled

'Enable Channel..." (enabled)

'Enable Event (default channel)...' (enabled)
‘Record Snapshot' (disabled)

Verify enable state of view buttons:
'New Connection...' (enabled)
‘Connect' (disabled)
'‘Disconnect’ (disabled)
'Refresh’ (enabled)

‘Delete’ (disabled)

'Start' (enabled)

'Stop' (disabled)

'Destroy Session...' (enabled)
‘Import..." (enabled)

'Record Snapshot' (disabled)

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Verify context sensitive menu items:
'Refresh’ (enabled)

‘Start' (disabled)

'Stop' (enabled

'Destroy Session..."' (disabled)

‘Import...' (disabled)

‘Enable Channel..." (disabled)

'Enable Event (default channel)...' (disabled)

Syscalls look crazy: | think | counted at least 50 events
enabled.

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass



4.1

4.12

5.1

52

53

5.4

55

5.6

57

5.8

6.1
6.2

71

72

View button enable state
(session active)

Destroy Session

Kernel Channel Handling

Preparation

Enable Channel on
session level (default
values)

Enable Channel on
domain level (default
values)

Enable Channel — channel
already exists

Domain Context Sensitive
menu

Channel Context Sensitive

menu

Disable Channel

Enable Channel

UST Channel Handling

Enable Channel on
session level (default
values)

Enable/Disable Channel

Kernel Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (syscalls)

Select started session

1) In the Control view select session 'MyOtherSession'

2) Click right mouse button

3) select 'Destroy Session..." in the context sensitive menu
4) Select 'Ok’ in the confirmation dialog box

1) Connect to remote host
2) Create new Session 'MyOtherSession'

1) Select session and right mouse click

2) Select menu item 'Enable Channel...!

3) Enter Channel name (e.g. myChannel) and keep default
values

4) Select Kernel

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click
2) Select menu item 'Enable Channel...!

3) Enter Channel name (e.g. MyOtherChannel)
4) Change values

5) Click on 'Ok’

1) Select domain 'Kernel' and right mouse click

2) Select menu item 'Enable Channel'

3) Enter Channel name (e.g. MyOtherChannel) and keep
default values

4) Click on 'Ok’

Select domain 'Kernel' and click right mouse button

Select channel 'MyChannel' and click right mouse button

1) Select channel 'MyChannel' and click right mouse button
2) Select 'Disable' menu item

1) Select channel 'MyChannel' and click right mouse button 2)
Select 'Enable’ menu item

1) Select session and right mouse click
2) Select menu item 'Enable Channel...!
3) Enter Channel name 'MyChannel'

4) Select UST

5) Click on Button 'Default’

5) Click on 'Ok’

Redo tests 5.7 and 5.8 with UST channel

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'

4) Select Radio button for 'Tracepoint Events'

5) Select top level tree node 'All'

6) Click on Ok

1) Select domain Kernel and click right mouse button
2) Select menu item 'Enable Events (default channel)...
3) Select 'Kernel'

4) Select Radio button for 'All Syscalls'

5) Click on Ok

Verify enable state of view buttons:
'New Connection...' (enabled)
‘Connect' (disabled)

'‘Disconnect’ (disabled)

'Refresh’ (enabled)

‘Delete’ (disabled)

'Start’ (disabled)

'Stop' (enabled)

'Destroy Session...' (disabled)
‘Import..." (disabled)

Verify that session is removed from the control view.

Verify that domain 'Kernel' is created under session and
channel is added under the domain. Verify that default
values for the channel are displayed in the Properties
view after selecting the channel in the tree.

Verify that channel is added under the domain. Verify
that correct values for the channel are displayed in the
Properties view after selecting the channel in the tree.

Verify that error dialog box is opened notifying that
channel already exists.

Verify context sensitive menu items:
'Refresh’ (enabled

'Enable Channel..." (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

'Calibrate” (enabled)

Verify context sensitive menu items:
'Refresh’ (enabled)

‘Enable Channel' (disabled)

'Disable Channel' (enabled)

'Enable Event (default channel)...' (enabled)
'Add Context...” (enabled)

Verify that channel is disabled (disabled channel icon
shown, state DISABLED shown in Properties view, menu
item 'Disable’ is disabled and menu item 'Enable’ is
enabled

Verify that channel is enabled (enabled channel icon
shown, state ENABLED shown in Properties view, menu
item 'Disable' is enabled and menu item 'Enable’ is
disabled

Verify that domain 'UST global' is created under session
and channel is added under the domain. Verify that
default values for the channel are displayed in the
Properties view after selecting the channel in the tree.

See 5.7/5.8

Verify that default channel (channel0) is create under
domain 'Kernel' and that all tracepoint events are added
under the channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Verify that event with name syscalls is added under the
default channel (channel0) with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=SYSCALL,
State=ENABLED)

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass

pass



7.3

7.4

7.5

7.6

7.7

8.1

8.2

8.3

8.4
8.5

8.6

Enable Event on Channel
level (Dynamic Probe)

Enable Event on Channel
level (Dynamic Function
Probe)

Disable Event

Enable Event

Enable Tracepoint Event
using filter in tree (Bug
450526)

UST Event Handling

Enable Event on session
level (all tracepoints)

Enable Event on domain
level (wildcards)

Enable Event on Channel
level (log level)

Enable Event on Channel
level (log level oly)

Enable/Disable Event

Enable Tracepoint Event
using filter in tree (Bug
450526)

Contexts Handling

1) Select a channel (e.g. channel0) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Probe’

4) Enter Event Name 'MyEvent' and Probe (e.g. 0xc0101280,
see file /boot/System.map<kernel version>)

5) Click on Ok

1) Select a channel (e.g. channel0) and click right mouse
button

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Dynamic Function Entry/Return
Probe'

4) Enter Event Name 'MyOtherEvent' and Probe (e.g.
create_dev, see file /boot/System.map<kernel version>)
5) Click on Ok

1) Select multiple events under a channel (not syscalls) and
click right mouse button
2) Select 'Disable' menu item

1) Select multiple disabled events and click right mouse button
2) Select 'Enable’ menu item

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter a filter (e.g. sched) for the tracepoint tree and then
select All

4) Click on Ok

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...'
3) Select 'UST'

4) Select Radio button for 'Tracepoint Events'

5) Select top level tree node 'All"

6) Click on Ok

1) Select domain 'UST global' and click right mouse button
2) Select menu item 'Enable Events (default channel)...'
3) Select Radio button for 'Wildcard'

4) Enter a wildcard (e.g. ust*)

5) Click on Ok

113) Select a channel (create if necessary) and click right mouse
utton

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Log Level'

4) Enter Event Name 'MyEvent'

5) Select log level TRACE_ERR

6) Select radio button for loglevel

7) Click on Ok

g) Select a channel (create if necessary) and click right mouse
utton

2) Select menu item 'Enable Events..."

3) Select Radio button for 'Log Level'

4) Enter Event Name 'MyOtherEvent'

5) Select log level TRACE_INFO

6) Select radio button for loglevel-olny

7) Click on Ok

Redo tests 7.5 and 7.6 with UST events

1) Create Session

2) Select session, right-mouse click and select 'Enable Events
(default channel)'

3) Enter filter for the tracepoint tree and then select All

4) Click on Ok

Verify that event with name 'MyEvent' is added under the|

respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=Probe, State=ENABLED,
Address=0xc0101280, Event Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when
selecting a event in the tree (Event Type=Function,
State=ENABLED, Symbol=create_dev, Offset=0x0,
Event Name=MyOtherEvent)

Verify that all selected events are disabled (disabled
event icon is shown, state DISABLED is shown in
Properties view, menu item 'Disable" is disabled and
menu item 'Enable’ is enabled

Verify that selected events are enabled (enabled event
icon is shown, state ENABLED is shown in Properties
view, menu item 'Disable' is enabled and menu item
'Enable' is disabled

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

Verify that default channel (channel0) is create under
domain 'UST global' and that a wildcard event “*” is
create under the channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED)

Verify that event with wildcarded name (e.g ust*) is
added under the default channel (channel0) with state
ENABLED. Verify properties view show correct values
when selecting a event in the tree (Event
Type=TRACEPOINT, State=ENABLED)

Verify that event with name 'MyEvent' is added under the

respective channel with state ENABLED. Verify
properties view show correct values when selecting a
event in the tree (Event Type=TRACEPOINT,
State=ENABLED, Log Level=<=TRACE_ERR, Event
Name=MyEvent)

Verify that event with name 'MyOtherEvent' is added
under the respective channel with state ENABLED.
Verify properties view show correct values when

selecting a event in the tree (Event Type=TRACEPOINT,

State=ENABLED, Log Level= ==TRACE_INFO, Event
Name=MyOtherEvent).

See 7.5/7.6

Verify that only the selected trace points (filtered) are
enabled and not all UST trace poionts

Address is not printed in properties view. Fix was
already available in master but not yet cherry-picked on
stable-3.1

Since LTTng Tools 2.2 the event type displayed in the
list command is function instead of probe.

event name is "ust*" including quotes. This will make subsequent
commands fail (e.g disable). It used to be necessary on bash shell.
Failure due to org.eclipse.remote API implementation for signle
and double quotes: 455382

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a range (e.g. <=
TRACE_ERR) This will be displayed by the properties
view now

Note: In LTTng backend v2.4 and later provide
information if a loglevel is for a single level (e.g. ==
TRACE_INFO) This will be displayed by the properties
view now

pass

pass

pass

pass

pass

pass

pass

pass

pass

address not allowed Command to change state o
Command failed! Command: Ittng --mi xml enabl
Error Ouptut:
Error: Event myEvent: Non-default channel exists
Return Value: 8

<?xml version=

.0" encoding="UTF-8"?>

utp

Command to change state of events failed
Command failed! Command: Ittng --mi xml enabl
Error Ouptut:

Error: Event bob: Non-default channel exists withi
Return Value:
<?xml version="1.0" encoding="UTF-8"?>

utp



9.1

9.2

9.3

101

10.2

1

111

11.2

Add Context (to channel)

Add Context (to channel)

Add Context (to event)

Enable Events (from
Provider)

Enable Kernel Events

Enable UST Events

Importing to Project

Preparation

Import to project

1) Select kernel channel and click right mouse button
2) Select menu item 'Add Contexts...

3) Expand tree and select some contexts (e.g prio, procname, Verify that command is successful (no error).

pid)
4) Click on 'Ok’

1) Select UST channel and click right mouse button
2) Select menu item 'Add Contexts..."

NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

Verify that command is successful (no error).
NOTE 1: There is no way to retrieve added contexts
from the trace. Therefore GUI cannot display this

3) Expand tree and select contexts procname, pthread_id, vpid information.

and vtid
4) Click on 'Ok’

1) Select 1 Kernel tracepoint event and click right mouse
button
2) Select menu item 'Add Contexts...

3) Expand tree and select some contexts (e.g prio, procname,

4) Click on 'Ok’

Note: only when using LTTng Tools 2.0.x - 2.1.x. For v2.2 or

later this menu item has to be disabled

1) Create a new session

2) Select multiple Kernel Tracepoint events under Providers —

Kernel

3) click right mouse button

4) select menu item 'Enable Event...!
5) Select newly created session

6) Select 'Ok’

1) Make sure that UST application is running on remote host

(see step 0)
2) Create a new session
3) Create a channel under domain 'UST global'

4) Select multiple UST Tracepoint events under Providers ->

<UST Process>

5) click right mouse button

6) select menu item 'Enable Event...!
7) Select newly created session

8) Select newly created channel

9) Select 'Ok’

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

5) Start Tracing

6) Stop Tracing after a few seconds
7) Create new Tracing Project

1) Select session from 11.1 and click right mouse button
2) Select 'Import..."
3) Select Ok

NOTEZ2: For UST only contexts procname, pthread_id,
vpid and vtid are supported

Verify that command is successful (no error).
NOTE: There is no way to retrieve added contexts from
the trace. Therefore GUI cannot display this information.

Verify that domain 'Kernel' is created under the new
session. Verify that default channel 'channel0' is created
under the domain. Verify that selected events are added
under the channel and are ENABLED.

Verify that selected events are added under the selected
channel and are ENABLED.

After 2 verify that all traces are selected by default and
also that the tracing project with name 'Remote’ is
selected.

Verify that during import a progress dialog is opened to
show the progress of the import operation.

Verify that traces are imported to the project wiith name
Remote and its Traces folder. Verify that for the kernel

trace the trace type "LTTng Kernel Trace" is set and for
the UST traces the trace type "LTTng UST Trace" is set.

Create Experiment, select all traces and open
Experiment. Make sure that all view are populated
correctly in the LTTng Kernel Perspective.

Per event adding of context is not supponed by LTTng
Tools anymore (starting from LTTng 2.2)

duplicated event, and gives a failure.
Command to change state of events
failed

Command failed! Command: Ittng --mi
xml enable-event log -u -s
MyOtherSession -c¢ Grimace --tracepoint
Error Ouptut:

Error: Event log: UST event already
enabled (channel Grimace, session
MyOtherSession)

Return Value: 55

<?xml version="1.0" encoding="UTF-
8"?>

<command><name>enable-
event</name><output><events><event>
<name>log</name><type>TRACEPOIN
T</type><enabled>false</enabled><filter
>false</filter><exclusion>false</exclusio
n><success>false</success></event></
events></output><success>false</succe
ss></command>



11.3

11.4

13.1

13.1

14.1

14.2

14.3

14.4

14.5

15.1

15.2

Import to project
(Overwrite)

Import to project
(Rename)

Import to project
(Overwrite Confirmation)

Refresh

Refresh

Calibration

Preparation

Calibrate

Event Filtering (LTTng
2.1)

Preparation

Enable UST Event on
session level

Enable UST Event from
provider

Create trace

Create Session With
Advanced Options
LTTng v2.1)

Create Session Dialog -
Advanced Button

1) Repeat step 1 — 3 of test case 11.2

2) In dialog box select 'Overwrite existing traces without
warning'

3) Select Ok

1) Repeat step 1 — 3 of test case 11.2

2)Select Ok

3) For each trace a confirmation dialog will open:
Select 'Rename' and change trace name

4) Select 'OK'

1) Repeat step 1 — 3 of test case 11.2

2)Select Ok

3) For each trace a confirmation dialog will open:
Select 'Overwrite'

4) Select 'Ok’

Press refresh button and context sensitive menu item for
different selections

1) Create new session

2) Enable all Kernel Tracepoint events
3) Enable all Kernel sycalls

4) Enable all UST events

1) Start Tracing

2) Select Domain 'Kernel' and click right mouse button
3) Select menu item Calibrate

4) Redo step 2-3 with domain 'UST global'

5) Stop tracing

For the tests below a Ubuntu machine with LTTng 2.1 installed

(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Connect to remote host
2) Create new Session 'FilterSession’

1) Select session and click right mouse button

2) Select menu item 'Enable Events (default channel)...'
3) Select 'UST'

4) Select Radio button for "Tracepoint Events'

5) Select one tracepoint

6) Enter filter expression on a event field

7) Click on 'Ok’

1) Execute 14.3

2) Select one UST Tracepoint event under Providers -> <UST
Process>

3) click right mouse button

4) select menu item 'Enable Event..."

5) Select newly create session and channel

6) Enter filter expression on a event field

7) Click on 'Ok’

1) Start Tracing

2) Stop Tracing after a view seconds
3) Import Trace to Project

4) Open Trace

5) Destroy Session

For the tests below a Ubuntu machine with LTTng 2.1 installed

(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx)

1) Open Create Session Dialog box
2) Select "Advanced >>>"
3) Select "<<< Basic"

Verify that traces are imported and existing traces are
overwritten

Verify that traces are imported with a different name

Verify that traces are imported and existing traces are
overwritten

Verify that the Control View is refreshed. -

Verify that Calibrate command is executed without error.
he testcase is 1o Doed if no Error occurred.

See also calibrate section in [Nk below for a Use Case 0

That feature. hitp://tng.org/files/doc/man-

pages/man 1/Ittng. T.htm!

Verify that default channel (channel0) is create under
domain 'UST global' and that the corresponding event is
created under the channel with state ENABLED.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter)

Verify that selected event is added under the selected
channel.

Verify that Properties view shows correct values for this
event (Event Type=TRACEPOINT, State=ENABLED,
Filter=with filter)

Make sure that only events are shown in the events
table that met the condition in the filter expressions

After 2) verify that advanced options are shown (e.g.
Trace Path, Protocol, Address and Port)

After 3) verify that advanced option are not shown and
only basic options are there (Session Name and Session
Path)

Pass


http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html
http://lttng.org/files/doc/man-pages/man1/lttng.1.html

Create Session Dialog -
Check box "Use same
protocol and address for

1) Open Create Session Dialog box and select "Advanced
>>>"

2) Uncheck checkbox"Use same protocol and address for data

and control"

3) Check checkbox "Use same protocol and address for data

After 2) verify that data Protocol and data Address is

enabled. Note that the ports cannot be configured for net
and net6 when this button is unchecked. -> port text

fields are disabled

After 3) Verify that data Protocol and data Address are

16.3  data and control" and control" disabled
1) Open Create Session Dialog box and select "Advanced
Create Session Dialog -  >>>" Verify that the data protocol dropdown menu shows net,
16.4  Protocol list net6 and file
1) Open Create Session Dialog box and select "Advanced
>>>"
Create Session Dialog -  2) Uncheck checkbox "Use same protocol and address for After 2) verify that the data protocol dropdown menu
15.5  Protocol list 2 data and control" shows net, net6, tcp and tcp6
After 2) verify that net6 is propagated to the data
protocol and and that the data and control port text fields
1) Open Create Session Dialog box, select "Advanced >>>"  are enabled
Create Session Dialog -  2) Select net6 for Control Protocol After 3) verify that file is propagated to the data protocol
15.6  Protocol propagation 3) Select file for Control Protocol and that the data and control port text fields are disabled.,
Create Session Dialog - 1) Open Create Session Dialog box, select "Advanced >>>"  After 2) verify that the IP address is propagated to the
15.7  Address propagation 2) Enter IP address data address field
1) Open Create Session Dialog box and select "Advanced
>>>"
2) Uncheck checkbox "Use same protocol and address for
data and control"
3) Select tcp for control protocol and tcp6 for data protocol
Create Session Dialog -  4) Check checkbox "Use same protocol and address for data  After 4) make sure that both data and control protocol
15.8  Protocol propagation 2 and control" show net
Verify that the traces are stored on the remote host
under /tmp/testTraces/<session name + date>/kernel
and /tmpl/testTraces/<session name +
1) Open Create Session Dialog box and select "Advanced date>/ust/<application(s)> repectively.
>>>"
2) Enter session name, select file protocol and enter directory  After 2) make sure that the Session Path in the Property
/tmpltestTraces/ in address field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to
15.9  protocol 5) Destroy session transfer the traces to the tracing project.
Verify that the traces are stored on the remote host
under /tmpl/testTraces/newPath/kernel and
1) Open Create Session Dialog box and select "Advanced /tmpltestTraces/newPath/ust/<application(s)>
>>>" repectively.
2) Enter session name, select file protocol and enter directory
/tmp/tmpTraces/ in address field, enter /newPath in "Trace After 3) make sure that the Session Path in the Property
Path" text field and press ok View shows the URL with the configured parameters
3) Enable events, start tracing, wait for a few seconds, stop
tracing Verify that the remote import dialog box opens at step 4 After import the root directory is newPath. However |
Create trace with file 4) Import traces to a existing tracing project (as described in test cases 11.x) and it is possible to expected tmpTrace with sub-dir newPath. Needs to be
15.10  protocol and trace path 5) Destroy session transfer the traces to the tracing project. investigated
Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/Ittng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
1)|Stgn relayd on Eclipse local machine (default settings: Ittng- repectively.
rela;
2) Open Create Session Dialog box and select "Advanced After 3) make sure that the Session Path in the Property
>>>" View shows the URL with the configured parameters
3) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field and press ok After 5) Verify that dialog box for selecting a tracing
4) Enable events, start tracing, wait for a few seconds, stop project is openend that after selecting a project and
tracing pressing next the default trace import wizard opens.
Create trace with net 5) Import traces to a existing tracing project Then verify that it is possible to transfer the traces to the
15.11  protocol 6) Destroy session tracing project.



15.12

15.13

15.14

16.1
16.2
16.3

16.4

16.5

16.6

16.7

16.8

16.9

16.10

16.11

171

Create trace with tcp
protocol and port

Live Streaming Session
(UST) - Initial
implementation

Live Streaming Session
(Kernel) - Inititial
Implementation

Preferences

Open Preference Dialog
Enable Logging
Disable Logging

Test Logging level none

Test Verbose Logging
(Level 1)

Test Verbose Logging
(Level 2)

Test Verbose Logging
(Level 3)

Append Mode

Change Tracing Group

Change execution timeout

Reset

Create Channel with

advance features (LTTng

2.2 features)

1) Uncheck checkbox "Use same protocol and address for
data and control"

2 ) Start relayd on Eclipse local machine with speCIfed ports
(Ittng-relayd -C tcp://0.0.0.0:1234 -D tcp://0.0.0.0:5678

3) Open Create Session Dialog box and select '‘Advanced
>>>"

4) Enter session name, select tcp protocol and enter IP
address of Eclipse local machine in address field, specify data
and control ports and press ok

5) Enable events, start tracing, wait for a few seconds, stop
tracing

6) Import traces to a existing tracing project

7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd)

2) Select Live Mode

3) Open Create Session Dialog box and select "Advanced
>>>"

4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok
5) Enable UST events (per UID channel), start tracing, wait for
a few seconds, stop tracing
6) Import traces to a existing tracing project
7) Destroy session

1) Start relayd on Eclipse local machine (default settings: Ittng-
relayd
2) Select Live Mode
3) Open Create Session Dialog box and select "Advanced
>>>"
4) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field, keep
defaults for Live Connection and Live Delay, and press ok
5) Enable Kernel events, start tracing, wait for a few seconds,
stop tracing
6) Import traces to a existing tracing project
7) Destroy session

Open Preferences (Menu -> Preferences -> Tracing -> LTTng
Tracer Control Preferences)

In Tracer Control Prferences, check checkbox Logging
In Tracer Control Prferences, uncheck checkbox Logging

Execute 16.2 and execute some commands (e.g. create
session, enable event)

1) Execute 16.2

2) select verbose level Level 1

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2) select verbose level Level 2

3) Execute some commands (e.g. create session, enable
event)

1) Execute 16.2

2) select verbose level Level 3

3) Execute some commands (e.g. create session, enable
event)

Check checkbox Append, restart Eclipse and open Tracer
Control Preferences

Change Tracing group (e.g. tracing2) and execute a command
(while logging enabled)

Change Execution Timeout

Reset to defaults

For the tests below a Ubuntu machine with LTTng 2.1 installed
(with Ittng tools 2.1.x) is required. Either create a VM machine
yourself (e.g. on Virtualbox) or install it locally on your native
Ubuntu (if correct version). Make sure that the root session
daemon is running (sudo lttng list -k) and have one UST
process running (e.g. from Ittng-tools git repository under
tests/hello.cxx).

Verify that the traces are stored on the Eclipse local
machine under /home/<user name>/Ittng-traces/<remote
machine name>/<session name + date>/kernel and
/home/<user name>/Ittng-traces/<remote machine
name>/<session name + date>/ust/<application(s)>
repectively.

After 4) make sure that the Session Path in the Property
View shows the URL with the configured parameters

After 6) Verify that dialog box for selecting a tracing
project is openend that after selecting a project and
pressing next the default trace import wizard opens.
Then verify that it is possible to transfer the traces to the
tracing project.

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated
when new data arrives

No way to specify destination in tracing project.
No check for name collision of the trace name
Not possible yet to trace per PID

XML Analysis view cannot be opened

Verify that session is created successfully. Verify that
after 6) the trace appears in the Traces directory of
Remoter project. Verify that relevants views are updated

when new data arrives Performance needs to be investigated.

Verify that tracer control preferences exists and shows
Tracing Group, Logging, Log File (always disabled),
Append, Verbose Level (None, Level 1, Level2 Level 3)
Verbose Level radio buttons will be enabled

Verbose Level radio buttons will be disabled

Make sure that log file is created and contains the
executed commands and command replies

Make sure that log file contains the executed commands
with -v option (e.g. Ittng -v create session) and the
command replies come with debug information

debug information of output passed in the errcr stream -> the error
stream is not
455801

Make sure that log file contains the executed commands
with -vv option (e.qg. Ittng -vv create session) and the
command replies come with debug information

debug information of output passed in the error stream -> the error
stream is not
455801

Make sure that log file contains the executed commands
with -vvv option (e.g. Ittng -vvv create session) and the
command replies come with debug information

debug information of output passed in the error stream -> the error
stream is not
455801

Verify that tracer control preferences are persisted and
the log file is opened in append mode (old file is not
overwritten)

Verify that Ittng command is executed with command lin
opti;;n -g <group>. Ignore any command reply errors (if
any;

After verify that values smaller than 5 and bigger than
600 are rejected

Incorrect command-line was build (Bug 459444)

Verify: Group=tracing, Logging is deselected, Append is
deselected, Verbose Level=None), and Command
Timout is 15



17.2

17.3

17.4

17.5

17.6

17.7

17.8

17.9

18.1

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select Checkbox 'Configure metadata channel'

4) Update all text boxes

5) Click on 'Ok’

Configure Metadata
channel (kernel)

Configure Metadata

channel (UST) 1) Re-do 17.2 with a UST channel

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!

3) Fill in channel name

4) Fill in 1048576 in 'Maximum size of trace files' (and also
subbuf-size)

5) Fill in 2 in 'Maximum number of trace filesfiles'

6) Click on 'Ok’

7) Enable all kernel events

8) Start, wait and stop tracing.

Configure File rotation
(kernel)

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'
3) Fill in channel name
4) Select UST
5) Fill in 262144 in 'Maximum size of trace files' (and also
subbuf-size;
6) Fill in 2 in 'Maximum number of trace filesfiles'
7) Click on 'Ok’
Configure File rotation 8) Enable all kernel events
(ust) 9) Start, wait and stop tracing.

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel..."
3) Select UST
4) Select Kernel
Buffer Type - toggle 5) Slect cancel
UST/kernel

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!
3) Select UST
4) Enter Channel Name
5) Select 'Ok’
Default UST Buffer Type

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...'

3) Select UST

4) Select 'Per PID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all kernel events

9) Start, wait and stop tracing.

per PID UST Buffer Type 10) Import trace

Prequisite: Multiple UST Applications need to run

1) Create and select session and click right mouse button
2) Select menu item 'Enable Channel...!

3) Select UST

4) Select 'Per UID buffers'

5) Enter Channel Name

6) Select 'Ok’

8) Enable all kernel events

9) Start, wait and stop tracing.

per UID UST Buffer Type 10) Import trace

Snapshot Channel
(LTTng 2.3 features)

Preparation Connect to a node with LTTng 2.3 installed

1) Click right mouse button on 'Sessions'
2) Select 'Create Session..." in the context sensitive menu
3) Enter session name 'MySession', keep 'Session Path’ empty
4) Select checkbox 'Snapshot Mode'
Create Snapshot Session 5) Select 'Ok’

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig checkbox is disabled. Verify after
5) that metadata channel was created under the kernel
domain. Also verify in the properties view that all
parameters are set correctly when selecting the channel
metadata.

Verify after 3) that 'Channel Name' is set to metadata
and the correspondig checkbox is disabled. Verify after
5) that metadata channel was created under the domain
UST global. Also verify in the properties view that all
parameters are set correctly when selecting the channel
metadata.

Command is successful. However tracer doesn't create
metadata channel

After 8) verify on the trace node that trace files are not

bigger than 1048576 bytes Kernel trace is generated corretly with LTTng 2.5.4

After 9) verify on the trace node that trace files are not
bigger than 262144 bytes

Verify after 2 and 4 that the radio buttons for the buffer
type is disabled and the buffer type "Global shared
buffers" is selected which is the value for the kernel
tracer.

Verify after 3) that the radio buttons are enabled an no
buffer type is selected

Verify after 5) that the default buffer type is configured
for that channel (see properties view). Note for LTTng
Tools 2.2 the default is per-PID and for LTTng Tools 2.3
and later it is per-UID

Verify after 6) that the per-pid buffer type is configured
for that channel (see properties view). After 10) make
sure that for each UST application one trace is created

Verify after 6) that the per-pid buffer type is configured
for that channel (see properties view). After 10) make
sure that only one trace is created even multiple UST
applications are running.

Verify that new session is added under the Session tree
node. Verify properties in Properties view (by selecting
the session in the Control view):

'Session name' (=MySession)

'Snaphshot ID' (=1)

‘Snapshot Name' (=snapshot-1)

'Session Path' (=/home/<user>/traces/MySession_<date
and time>) and 'State' (<SINACTIVE)

Make sure that the button and menu item ‘Record
Snapshot' is disabled



18.2

18.3

18.4

18.5
18.6
18.7

18.8

18.9

18.10

18.11

19.1

Enable Kernel Event

Start Session

Record snapshot

Create another snapshot
session

Enable UST Events
Start UST session

Record snapshot over
multiple sessions

Import traces

Stop and destroy sessions

Network snapshot session

Command Script

Execute command sript

Enable all Kernel Tracepoint and syscall events

a) Select session and click on button 'Start'
b) Redo test with context sensitive menu item 'Start'

select session and record 2 snapshots: Once with button
'Record Snapshot' and once with context-sensitive menu item
'Record Snapshot'

session name ustSession (as described in 18.1)
Enable all UST events
see 18.3

Select kernel and ust session (see 18.1 and 18.5) and click on
'Record snapshot' button

Open Import dialog (see 11.2)

Stop and destroy both sessions

1)|Start relayd on Eclipse local machine (default settings: Ittng-
relay

2) Open Create Session Dialog box, select 'Snapshot
Mode'and select "Advanced >>>"

3) Enter session name, select net protocol and enter IP
address of Eclipse local machine in address field and press ok
4) Enable events (UST and Kernel), start tracing, and recored
a few snapshots, stop tracing

5) Import traces to a existing tracing project

6) Destroy session

Create a command script to create a session with kernel and
ust events enabled.

Verify that channel and events a successful enabled

Verify that Session icon changes to 'ACTIVE' icon. Verify
that property view shows 'ACTIVE' for the session state

Make sure that the button and menu item 'Record
Snapshot' is enabled. Also make sure that the Button
and menu item 'Import' is enabled.

Commands succeed without error

Make sure that snapshot session is created successfully
Verify that channel and events a successful enabled
see 18.3

Command succeeds without error

Verify that 4 snapshots are available (3 kernel and 1
UST). Verify that all snapshots are imported to the
selected tracing project

Verify that sessions are destroy successfully

Make sure that all steps were successfull. Also, import
the traces using the standard import instead of the
remote import

Make sure that each command of script is executed and
script execution is without errors

LTTng tools returns Oxffffffff for live timer and the Control view
parses it as a long and hence the value is bigger than 0. This leads
to that the session is seen as live session and hence the import of
the trace fails.



Section Pass Fail ToDo Comment
GDB Tracing 28 | o |2
Target: Ubuntu 14.10 64 bit

Step Test Case Action Verification Comment

1 Preparation

1.1 Step 1 Open and reset the GDB Trace perspective GDB Trace perspective opens with correct views Pass
1.2 Step2 Open Navigator View (used for independent verification) Navigator View opens Pass
1.2 Step 3 Open Debug View (used for independent verification) Debug View opens Pass
2 Project Creation

21 New Project Wizard Open New Tracing Project Wizard Tracing Project Wizard opens Pass

2.2 Create project Specify a project name and finish Tracing project appears in Project Explorer Pass

2.3 Project structure Close and open the new Tracing project Project contains the Traces folder Pass

Pass

3 Traces Folder

3.1 Traces Folder menu Select the Traces folder and open its context menu Correct menu opens (Open Trace, Import, New Folder, ...) Pass

3.2 Trace Import Wizard Select Import Trace Trace Import Wizard appears Pass

33 Import traces Select a GDB Trace from samples directory and finish Imported traces appear in Folders with proper icon Pass
4 Trace Configuration

Verify that an Error Dialog opens that notfiies the user to select
4.1 Project/executable selection Double-click on an un-configured trace the trace executable Pass

1) Right mouse click on trace
2) Select menu item "Select Trace Executable"

4.2  Select Trace Executable 3) Fillin the proper values in dialog and finish Trace is configured (4.3 is successful, when 4.2 was successful) Pass
4.3 Open configured trace Double-click on a configured trace Trace is opened, events table and views are populated Pass  Content column is missing (Bug 459711)
5 Source Code Lookup
The corresponding source code location is selected in the source
5.1 Select event With mouse select an event in events table code file. Pass
The corresponding source code location is selected in the source
5.2 Select another event redo 5.1 code file. Pass
6 Events Table Navigation
Each keystroke modifies the selected event and the corresponding
6.1 Arrow keys Update the current event using up/down keys within window source code location is selected in the source code file. Pass
Table is refreshed to display new current event and the
corresponding source code location is selected in the source code
6.2 Scrolling Update the current event using up/down keys outside windo file Pass
6.3 PgUp/PgDn Update the current event using PgUp/PgDn keys Table is scrolled accordingly Pass
Table jumps from first to last event and the corresponding source
6.4 Home/End Update the current event using Home/End keys code location is selected in the source code file Pass
7 Events Searching & Filtering
71 Search In the search bar, enter some RE Events corresponding to the RE are highlighted Pass
7.2 Navigation Navigate through highlighted events using Enter/Shift-Enter Next/previous highlighted event selected accordingly Pass
7.3 Un-search In the search bar, clear the RE Events are displayed normally Pass
7.4 Filter In the filter bar, enter some RE Only events matching RE are displayed Pass
7.5 Un-filter Ithe filter bar, clear the RE Events are displayed normally Pass
7.6 Filter & Search In the filter bar, enter some RE; likewise in the search bar Events are filtered and highlighted accordingly Pass
7.7  Search &Filter In the search bar, enter some RE; likewise in the filter bar Events are filtered and highlighted accordingly Pass
8 Events Synchronization

8.1 Synch from Events View Click on an event in the Events View Trace Control View is updated; Debug View is updated Pass
8.2 Synch from Trace Control Go up/down from the Trace Control View Events View is updated accordingly Pass  When overlay-scrollbars are used, the slider is not visible and this is not possible



Section Pass Fail
Tracing RCP 31
Target: Windows 8.1 64 bit
Step Test Case Action Verification
1 Start RCP
1.1 Start Tracing RCP Open RCP from command line or file explorer Tracing RCP opens in default perspective
Start Tracing RCP with text ~ Open RCP from command line with --open <trace name with
1.2 trace absolut path> Trace will be opened with auto-detected trace type
Start Tracing RCP with Open RCP from command line with --open <trace name with  Verify that the same trace that was previously linked into the
1.3 previously opened text trace absolut path>. Use same trace than 1.2 Traces folder is opened and not a new trace entry is created
Start Tracing RCP with Kernel Open RCP from command line with --open <kernel trace Tracing RCP is opened, the trace is linked to the Tracing project,
1.4 CTF trace name with absolut path> the kernel analysis trace type is selected and trace is opened.
Start Tracing RCP with
previously opened Kernel CTF Open RCP from command line with --open <kernel trace Verify that the same trace that was previously linked into the
1.5 trace name with absolut path>. Use same trace than 1.4 Traces folder is opened and not a new trace entry is created
Verify that a new trace is linked to the Tracing project, the trace
Open RCP from command line with --open <trace name with type selection dialog is opened and after selecting the
Start Tracing RCP with new absolut path>, where the name of trace is the same than 1.2, correspoinding trace type and trace is opened. Verify that the new
1.6 trace with name conflict but the trace is located at a different location on disk trace name has a integer number a suffix added.
Open RCP from command line with --open <kernel trace with Verify that a kernel trace is linked to the Tracing project, the
absolut path>, where name of trace is the same than 1.4, but kernel analysis trace type is selected and trace is opened. Verify
1.7 Re-do 1.6 the trace is located at a different location on disk that the new trace name has a integer number a suffix added.
Start Tracing RCP with non-
1.8 trace file Open file that is not a trace Trace is imported (linked) however default icon (From Eclipse) is set!
2 File menu
Use Menu "File -> Open Trace ..." In the file dialog select a
2.1 Open Trace (File) text trace and select open. Trace will be opened with auto-detected trace type
Open Trace (File) with Use Menu "File -> Open Trace...". In the file dialog select a Verify that the same trace that was previously linked into the
2.2 previously opened text trace text trace and select open. Use same trace than 2.1 Traces folder is opened and not a new trace entry is created
Use "Menu File -> Open Trace ..." . In the file dialog selecta  Verify that the trace is linked to the Tracing project, the kernel
2.3 Open Trace (Directory) file of Kernel CTF trace directory and select open. analysis trace type is selected and trace is opened.
Open Trace (Directory) with  Use "Menu File -> Open Trace ..." . In the file dialog select a
previously opened Kernel CTF file of Kernel CTF trace directory and select open. Use same Verify that the same trace that was previously linked into the
2.4 trace trace than 2.3 Traces folder is opened and not a new trace entry is created
Use Menu "File -> Open Trace ..." In the file dialog select a Verify that a new trace is linked to the Tracing project, the trace
text trace and select open, where the name of trace is the type selection dialog is opened and after selecting the
Open Trace File with name same than 2.1, but the trace is located at a different location correspoinding trace type and trace is opened. Verify that the new
2.5 conflict on disk trace name has a integer number a suffix added.
Use "Menu File -> Open Trace ..." . In the file dialog select a
file of Kernel CTF trace directory and select open, where the Verify that a kernel trace is linked to the Tracing project, the
name of trace is the same than 2.3, but the trace is located at kernel analysis trace type is selected and trace is opened. Verify
2.6 Re-do 2.5 a different location on disk that the new trace name has a integer number a suffix added.
2.7 Open file Open file that is not a trace Trace is imported (linked) however default icon (from Eclipse) is set
Verify that RCP is restarted with the previously open perspective
2.8 Restart Use Menu File -> Restart and trace
2.9 Exit Use Menu File -> Exit Tracing RCP exits
3 Window Menu
Use Menu Window -> Show Perspective -> Tracing
31 Open Perspective Perspective Tracing perspective is opened

To Do

Comment

[ o 3

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Comment

The kernel trace opens in an editor but the editor of the first trace
gets activated. Bug 443461.



3.2
33

3.4

3.5

4.1

4.2

4.2

44

4.5

5.1

5.2

5.3
5.4

6.1

Open View
Preferences

Save Perspective As

Reset Perspective

Help Menu

Help Contents

Help Contents (shortcut)
Install new Software
About

Version + Copyright
Content
TMF presence

LTTng presence
PCAP Network analysis
presence

BTF presence

Upgrade

Upgrade from previous
release

Use Menu Window -> Show View -> Select Tracing ->

Sequence Diagram
Use Menu -> Preferences

Make changes of perspective by moving views and use menu
Window -> Save Perspective As. Enter a perspective name

and select Ok

Make changes of perspective by moving views and use menu
Window -> Reset Perspective.

Use Menu -> Help -> Help Contents

Use key F1

Use Menu -> Help -> Install New Software... to install new

Eclipse feature

Use Menu -> Help -> About

Use Menu -> Help -> About -> Installation details

Open Tracing perspective

Open LTTng Kernel perspective

Open Network analysis perspective

Open BTF trace

Use Help -> Check For Updates

Sequence diagram view is shown
Preferences dialog is shown

Perspective with new name is stored

After confirming the reset operation the perspective is reset to the
default layout.

A message box is first shown: "The current document
displayed does not exist in the table of content". Bug
443459

Help content browser is opened. All Tracing related help is
included

Help content browser is opened. All Tracing related help is
included

Installation is successful

About dialog is opened all relevent information (e.g. version,
copyright years etc) is up-to-date and correct.

Go over all tracing features and plug-ins and verify that all have the
correct version and copyright years

Tracing perspective opens
LTTng Kernel perspective opens

Network analysis perspectiv opens
BTF trace opens correctl

RCP is upgraded NA



Target:

Step

0

0.1

0.2

0.3
0.4

1.1

1.2

1.3

1.4

1.5

21

2.2
23

24
25

2.6

3.1

3.2

Section

LTTng 2.0 - Memory
Analysis

Test Case

Prerequisites

Download traces

Import trace with memory
event

Import trace without
memory event

Import non-UST trace

Project View

Check analysis can
execute

Pass

Action

Download UST trace with memory events
from
http://secretaire.dorsal.polymtl.ca/~gbastien
/traces/eclipse_mem_ust.tar.gz

Import the LTTng UST trace downloaded
above in Tracing project

Import one of the LTTng UST trace that
does not contain the memory events, for
example, the one used for the callstack
view

Import one LTTng Kernel trace

In the project explorer, expand the trace
that contains the memory events

In the project explorer, open and expand
the trace that contains the memory events,

Verify help message when right-click the memory analysis and select

applicable

Check analysis cannot
execute

Help

In the project explorer, expand the UST
trace that does not contain memory events
In the project explorer, open and expand
the UST trace that does not contain

Verify help message when memory events, right-click the memory

not applicable

analysis and select Help

Check analysis for another In the project explorer, expand a LTTng

trace type
View Management

Populate analysis's view

Open view
Close trace

Open trace
Close view

Re-open view
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Kernel trace

Open the UST trace with memory events
and expand the "UST Memory" analysis in
the project explorer

Double-click the UST Memory View under
the memory analysis

Close the trace

With the view already opened, open the
trace

Close the UST Memory Usage view

Double-click the UST Memory Usage view
under the memory analysis in project
explorer.

Drag move xy chart left and right with
middle button

Zoom with mouse wheel up and down,
cursor inside xy chart

Fail

Verification

"Ust Memory" analysis is present and "normal"

A generic help message appears with the name of the
analysis.

"Ust Memory" analysis is present, but striked-out

The help message mentions the analysis is impossible to
execute and contains the requirement that is not fulfilled

"Ust Memory" analysis is not present

"Ust Memory Usage" View appears under the analysis

The UST Memory Usage view opens and triggers the memory
analysis. After the analysis, the XY chart is populated

The UST Memory Usage view is emptied.

The UST Memory Usage view is populated.
The view is closed.

The view opens and is automatically populated.

Time range is dragged. When mouse button is released, the
view refreshes with the new time range

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views.

To Do

Pass

Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass
Pass

Pass

Pass

Pass

Comment

Comment

But while dragging, nothing visible happen



3.3
34

3.5

3.6

4.1

4.2

4.3

Drag select time range Drag select time graph with right button

Mouse hover Hover mouse in xy chart anywhere

Drag mouse selection Drag select xy chart with left button

Click select with left button (begin time),

Shift key selection (end time)
Synchronization

Have the Histogram and UST Memory
Preparation Usage views both visible

Select a random time in another view

Select a new time range in UST Memory
Time range synchronization Usage view or in Histogram view.

Time synchronization

In any other view that supports range

Time range selection
synchronization, select a new range.

synchronisation

press shift key and click select another time most selected time and delta the time difference between T2-
T1

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new time
range is propagated to other views.

Tool tip shows values for each thread at the given timestamp

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right
most selected time and delta the time difference between T2-
T1

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right

Status bar is not updated

Second click-select just select the timestamp,
no range

Selected time line is updated. If selected time is outside current

range, time range is updated to include it. Clicking outside range does not work

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is

updated to include it View does not include T1 outside current range



Target:

Step

0
0.1

1.1

1.2

1.5

21

2.2
23
24
25
2.6
3.1
3.2

41

4.2

4.3

4.4

4.5

4.6

Section
LTTng 2.0 - CPU Analysis

Test Case

Prerequisites
Import traces

Project View

Check analysis can
execute

Action

Import LTTng Kernel traces in Tracing project

In the project explorer, expand a LTTng
Kernel trace

In the project explorer, open and expand the

Verification

"CPU usage" analysis is present and "normal”

Verify help message when LTTng kernel trace, right-click the CPU usage A generic help message appears with the name of the

applicable

analysis and select Help

Check analysis for another In the project explorer, expand a non-LTTng

trace type
View Management

Populate analysis's view
Open view
Close trace

Open trace
Close view

Re-open view
View selection

Select an entry

Select another entry
Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Mouse hover

Kernel trace

Open an LTTng kernel trace and expand the
"CPU usage" analysis in the project explorer

Double-click the CPU usage View under the
CPU usage analysis

Close the trace

With the view already opened, open the trace

Close the CPU Usage view

Double-click the CPU Usage view under the
CPU usage analysis in project explorer.

Select an entry in the tree viewer section

Select another entry from the tree viewer

Drag move xy chart left and right with middle
button

analysis

"CPU usage" analysis is not present

"CPU Usage" View appears under the analysis

The CPU usage Usage view opens and triggers the cpu
analysis. After the analysis, both tree viewer and xy charts
are populated.

The CPU Usage view is emptied.
The CPU Usage view is populated.
The view is closed.

The view opens and is automatically populated.

A new series is added to the xy chart, corresponding to the
selected TID

A new series is added to the xy chart, and the previous TID's
series is not displayed anymore

Time range is dragged. When mouse button is released,
series are updated and new time range is propagated to
other views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, series are
updated and new time range is propagated to other views,

Zoom with mouse wheel up and down, cursor including the tree viewer beside the chart. The selected

inside xy chart

Scroll with mouse wheel up and down, cursor
outside xy chart

Click and drag vertical scroll bar

Drag select time graph with right button in xy
chart

Hover mouse in xy chart region anywhere

process remains the same.

Table scroll up and down. Selected process does not
change. Vertical scroll bar updated.

Tree viewer scrolls up and down. Selected process does not
change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, series are updated and new
time range is propagated to other views. Selected process
remains the same.

Tool tip shows the total and selected process (if any) cpu
usage at the time

To Do

Pass

Pass

Pass

Pass

Pass
Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass
Pass
Pass

Pass

Pass

Comment

Comment

But while dragging, nothing visible happens

It would be nice to display the process name instead of the tid



4.7

4.8

4.9

5.1

6.1

6.2

6.3

Drag mouse selection Drag select xy chart with left button

Click select with left button (begin time), press
shift key and click select another time (end

Shift key selection time)

Sort columns Click on column headers once then twice

Keyboard handling

Keyboard navigation in tree With focus on table, use UP, DOWN, HOME,
viewer END keys

Synchronization

Select a random time in another view

Select a new time range in CPU usage view or
Time range synchronization in Histogram view.

Time synchronization

Time range selection
synchronisation

CPU usage works with
experiments

In any other view that supports range
synchronization, select a new range.

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the left most selected time, T2 the
right most selected time and delta the time difference
between T2-T1

Status bar is not updated

Selection highlighted. Status bar of Eclipse is updated with
time information: T, T1, T2 and delta, where T is the time of
the mouse position, T1 the left most selected time, T2 the
right most selected time and delta the time difference
between T2-T1

Entries are sorted in ascending then descending order on
the column value. Selected process does not change.

Selected process is changed. xy chart selection is updated.
Vertical scroll bar updated.

Selected time line is updated. If selected time is outside

N " . ] No update if selected time outside current
current range, time range is updated to include it.

range

Time range is updated.

Selection is highlighted. If begin time (T1) of selected time
range is outside the current range, then time range is

- > xy chart range does not include T1 ouside
updated to include it

current range

Shift key does not work in xy chart and status bar not updated



Target:

Step

0

0.1
0.2
0.3

1.1
1.2

1.6

1.6.5
1.7

Section
Trace Synchronization

Test Case

Prerequisites

Import traces
Create experiment 1
Create experiment 2

View Management

Open Synchronization
View

Delete view

Open view

Open Experiment

Synchronize experiment

Open view when trace is
already loaded

Synchronize experiment
with constant offset

Open trace
Re-open experiment

Restart
Functionnalities
Open experiment 2
Go back to previous
experiment

Synchronize experiment

Pass

Action

Import the scp_dest and scp_src traces in the
synctraces.tar.gz file

Create an experiment containing those 2 traces
Create an experiment with any other trace

Use menu Window - Show View - Other ... »
Tracing - Synchronization
Close the Synchronization View

Use menu Window - Show View - Other ... -
Tracing - Synchronization

Open the experiment containing the 2
synchronizable traces

Right-click on the experiment and select
'Synchronize experiment'

1) Close Synchronization View
2) Load LTTng experiment
3) Open 'Synchronization' view

Try to offset a trace by a second

Open an Lttng Kernel trace

Open the experiment containing the 2
synchronized traces

Restart Eclipse

Open the experiment containing traces that do not
synchronize

Re-open the experiment with the synchronizable
traces

Right-click on the experiment and select
'Synchronize traces'

Fail

Verification

Verify that 'Synchronization' view is shown
Synchronization' view is removed from perspective

Synchronization' view is displayed and remains empty

Verify that the view is still empty

After a time, the view is populated with synchronization
result that say 'accurate’. And one of the original traces
has been replace by a trace with the same name, but
withan'_'at the end.

Verify that view is populated with synchronization data
from currently opened experiment

Visually verify that a synchronized trace is now
offsetted

Synchronization view is empty

View shows synchronization data from the experiment

Verify that view is populated with synchronization data
from experiment

Verify that the 'Synchronization' view is empty

Verify that the 'Synchronization' view contains the data
from the experiment

After a time, the view is populated and the
synchronization quality says 'Absent’

To Do

Comment

| o |2

Pass
Pass

Pass

Pass

Pass

Pass

Pass
Pass

Pass

Pass

Pass

Pass

Comment

Absent is not displayed



0.1

0.2

0.3

1.1

12

2.1

22

2.3
24

2.5
2.6
2.7
2.8
2.9

3.1

3.1

2.3

4.1

4.2

4.3

Target:

Section
XML analysis

Test Case

Prerequisites

Import traces

Get a test XML file

Make sure the XML file does

not exists in the project
XML file import

Verify analysis not present

Import XML file

View management

Populate the views

Open the 'Xml Control Flow
View'

Open another XML view

Close view

Open view when trace is
already loaded

Close traces

Open trace

Open another trace

Open LTTng Kernel trace
View selection

Select an entry in the table

Select entry in time graph

Select state in time graph

Mouse handling

Drag move time range

Zoom time range (mouse
wheel)

Zoom time range (mouse
drag)

Action

Import LTTng kernel traces
Download the test XML file here:

http://secretaire.dorsal.polymtl.ca/~gbastien/Xml4Tra

ces/Kernel.Linux.xml
The XML files are located in <workspace

directory>/.metadata/.plugins/org.eclipse.tracecompas

s.tmf.analysis.xml.core/xml_files. Delete the linux
kernel XML file if it exists.

In the project Explorer, expand any LTTng kernel
trace

Right-click the Traces folder, select Import XML
analysis and select the Kernel.Linux.xml file

Open an LTTng kernel trace

Double-click the 'Xml Control Flow View' under the

analysis

Double-click the 'Xml Resources View' under the
analysis

Close the XML view

Double-click one of the views under the analysis
Close all opened traces

Open an LTTng Kernel trace

Open a non-LTTng Kernel trace

Open an LTTng Kernel trace

Select an entry in the table

Select an entry in the time graph (empty region)

Select a state in the time graph

Drag move time graph left and right with middle
button

Zoom with mouse wheel up and down, cursor inside

time graph

Verification

Verify that there is no 'Xml kernel State System' analysis
Verify that the 'Xml kernel State System' analysis is now present]
under a LTTng kernel trace

The 'Xml kernel State System' analysis should have a + next to
it, expand it and there should be 2 views under it: "Xml Control
Flow View' and "Xml Resources View'

A view titled 'Xml Control Flow View' should open and it
should look quite similar to the Control Flow View

The new view replaces the 'Xml Control Flow View' and the
title changes to 'Xml Resources View'. This view is quite similar
to the Resources view's CPU entries.

The view is closed

The view opens with the correct title and is correctly populated.
The view is emptied.

The view is populated

The view is emptied.

The view is populated.

Same entry is highlighted in time graph.

Same entry is highlighted in table. Selected time line is updated.
Other views are synchronized to selected time.

Same entry is highlighted in table. State is highlighted in time
graph. Selected time line is updated. Other views are
synchronized to selected time.

Time range is dragged. When mouse button is released, states
are updated and new time range is propagated to other views.

Time range is zoomed in and out, relative to mouse cursor.
When mouse wheel is stopped for a short time, states are
updated and new time range is propagated to other views.

Time range is zoomed in and out. When mouse button is
released, states are updated and new time range is propagated to

Drag in time graph scale left and right with left button other views.

To Do

Pass

Pass

Pass

Pass

Pass
Pass

Pass
Pass
Pass
Pass
Pass

Pass

Pass

Pass

Pass

Pass

Pass

Comment

Comment

After opening the resources view and going
back to the Control Flow view the legend
shows an extra entry (for value 4). This is
due to a concorrency bug.



44

45

4.6

4.7

4.8

4.9

4.11

5.1

52

5.4

5.4

6.1

6.2

6.3

6.4

6.5

Mouse vertical scroll

Vertical scroll bar

Drag select time range

Double-click reset time range

Mouse hover (empty region)

Mouse hover (state)

Drag mouse seleection

Shift key selection
Keyboard handling

Keyboard navigation in table
(entry selection)

Keyboard navigation in table
(tree expansion)

Keyboard navigation in time
graph (process selection)

Keyboard navigation in time
graph (state selection)
Tool bar handling

Show Legend

Reset Time Scale
Select Previous/Next Event

Select Previous/Next Process

Zoom In/Out

Scroll with mouse wheel up and down, cursor outside
time graph

Click and drag vertical scroll bar

Drag select time graph with right button

Double-click left button on time scale

Hover mouse in time graph over empty region

Hover mouse in time graph over state

Drag select time graph with left button

Click select with left button (begin time), press shift
key and click select another time (end time)

With focus on table, use UP, DOWN, HOME, END
keys

With focus on table,
in Windows use LEFT, RIGHT keys while parent or
child process is selected

in Linux use SHIFT LEFT, RIGHT keys while parent
or child process is selected

With focus on time graph, use UP, DOWN, HOME,
END keys

With focus on time graph, use LEFT, RIGHT keys

Click Show Legend button

Click Reset Time Scale button
Click Previous/Next Event button

Click Previous/Next Process button

Click Zoom In/Out button

Table and time graph scroll up and down and remain aligned.
Selected entry does not change. Vertical scroll bar updated.

Table and time graph scroll up and down and remain aligned.
Selected entry does not change.

Selection highlighted. When mouse button is released, time
range is zoomed to selection, states are updated and new time
range is propagated to other views.

Time range is reset to full range, states are updated and new
time range is propagated to other views.

Tool tip shows entry name only.

Tool tip shows entry name, state name, date, start time, end
time, duration.

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right most
selected time and delta the time difference between T2-T1

Selection highlighted. Status bar of Eclipse is updated with time
information: T, T1, T2 and delta, where T is the time of the
mouse position, T1 the left most selected time, T2 the right most
selected time and delta the time difference between T2-T1

Selected process is changed. Time graph selection is updated.
Vertical scroll bar updated.

For parent process, tree is expanded or collapsed. Time graph
item expansion is updated. Vertical scroll bar updated. For child
process, left changes selection to parent, time graph selection is
updated. Vertical scroll bar updated.

Selected process is changed. Table selection is updated. Vertical
scroll bar updated.

Previous or next state is selected. Selected time is updated in
other views.

The legend dialog is opened and can be closed.

Time range is reset to full range, states are updated and new
time range is propagated to other views.

Previous or next state is selected. Selected time is updated in
other views.

Selected process is changed in table and time graph. Vertical
scroll bar updated.

Time range is zoomed in and out, relative to center of time
range. States are updated and new time range is propagated to
other views.



6.6 Filter Dialog Open Filter Dialog Verify that all buttons are working correctly

1) Open Filter Dialog
2) Deselect several processes
6.7 Filter Processes 3) Press Ok Verify that only selected entries are displayed in the view

Selected time line is updated. If selected time is outside current
7.1 Time synchronization Select a random time in another view range, time range is updated to include it.

Select a new time range in Resources view or in
7.2 Time range synchronization  Histogram view. Time range is updated.

Selection is highlighted. If begin time (T1) of selected time

Time range selection In any other view that supports range synchronization, range is outside the current range, then time range is updated to
7.3 synchronisation select a new range. include it With T1 outside current range, the time range is not updated to include it.



To Do

Section Comment

Network Trace analysis

Target:
Step Test Case Action Verification Comment
0 Prerequisites
0.1 Import traces Import the trace linked here
1 Trace Import
Open the Network Tracing In the project Explorer, expand any LTTng Verify that the events view, the properties and
1.1 perspective kernel trace stream list are displayed Pass
The trace is given a "network" icon. When
openned, the events view and histogram view is
1.2 Open trace Double-click on the "TeamSpeak2.pcap" trace opened Pass
2 View management
2.1 Populate the views Open the "TeamSpeak2.pcap" The views are updated Pass
One stream is available with endpoint A being
2.2 Look up stream Open the Stream list Fe:FF:FF:FF:FF.FF Pass
2.3 Close the trace The stream list is emptied Pass
2.4 Close view Close the view The view is closed Pass
Open view when trace is The view opens with the correct title and is
2.5 already loaded Re-open the trace. Open The Stream List correctly populated. Pass
2.6 Open a non pcap trace The stream list is emptied Pass
3 Stream List
3.1 Re-open trace Ensure only "TeamSpeak2.pcap” is opened The trace is opened Pass
Create a filter from the A filter named "FILTER stream eth 00:0c:29..." is
3.1 stream list Right click on stream 0, and select "create filter" created Pass

In the events table, right click on an event and
3.2 Apply filter select "Apply preset filter->00:0c:29..." 24/24 events pass the filter Pass


http://wiki.wireshark.org/SampleCaptures?action=AttachFile&do=get&target=TeamSpeak2.pcap

Section # Bug Reports # Open # Fixed

Bug Reports 0 10 11

Test Case Bug Title Bug Report Status

[LTTng] Index files of LTTng traces are

LTTng Control 15.11 imported as traces with unknown type https://bugs.eclipse.org/bugs/show_bug.cgi?id=436208 [Fixed
[TMF] Inconsistent behaviour of Open Trace
RCP 1.8, 2.7 feature for non-trace files https://bugs.eclipse.org/bugs/show_bug.cgi?id=436444 'Fixed
[TMF] Statistics View randomly doesn't show
TMF Statistics View 2.3 values after opening view for open trace https://bugs.eclipse.org/bugs/show_bug.cgi?id=436416 None Close since it cannot be reproduced

[TMF] Sequence Diagram Overview feature

Sequence Diagram 5.23 not working well on recent platform versions  https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442 Open
[TMF-RCP] Sequence diagram cannot be

Sequence Diagram 5.24 printed https://bugs.eclipse.org/bugs/show_bug.cgi?id=436440 Fixed

LTTng 2 - Memory
Analysis 3.5, 3.6, CPU [TMF] Status bar is not updated when

Analysis 4.7, 4.8 selecting time range in XY charts https://bugs.eclipse.org/bugs/show_bug.cgi?id=436853 Open

LTTng 2 - Memory

Analysis 4.1, CPU [TMF] Time selection outside current range

Analysis 6.1 should update current range in xy charts https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861 Open

LTTng 2 - Memory

Analysis 4.3, CPU [TMF] Time range selection outside current

Analysis 6.3, range should update current range in time

XmlAnalysis 7.3 graph views https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855 Open
[Ittng rcp] Warning message box shown when

RCP 4.1 first opening help contents https://bugs.eclipse.org/bugs/show_bug.cgi?id=443459 Open
[Ittng rcp] Opening a second trace with --open

RCP 1.4 activates the wrong editor https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461 Open
[TMF] Original experiment reappears after

Project View 6.5 rename and copy https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888 Open
"No trace type associated to that trace" when

Project View 6.5 opening copied experiment https://bugs.eclipse.org/bugs/show_bug.cgi?id=455414 Fixed
Sequence diagram interaction tooltip is hard

Sequence Diagram 3.1 to read on Ubuntu https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523 Open
Button gets disabled in print dialog of

Sequence Diagram 5.24 sequence diagram after clicking on it https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546 Open
Bookmark is not removed right away, only

Time Chart 5.6 when the view is refreshed. https://bugs.eclipse.org/bugs/show_bug.cgi?id=436323 Open

LTtng Control 16.5 -

16.7 Debug information not logged https://bugs.eclipse.org/bugs/show_bug.cgi?id=455801 [Fixed
Event table raw viewer selection not

Cusom Parsers 4.4/4.5 propagated to Properties view https://bugs.eclipse.org/bugs/show_bug.cgi?id=457852 Fixed

LTTng Control 16.9 [Control] Error adding tracing group https://bugs.eclipse.org/bugs/show_bug.cgi?id=459444 'Fixed



https://bugs.eclipse.org/bugs/show_bug.cgi?id=436208
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436444
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436416
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436442
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436440
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436853
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436861
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436855
https://bugs.eclipse.org/bugs/show_bug.cgi?id=443459
https://bugs.eclipse.org/bugs/show_bug.cgi?id=443461
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436888
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455414
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455523
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455546
https://bugs.eclipse.org/bugs/show_bug.cgi?id=436323
https://bugs.eclipse.org/bugs/show_bug.cgi?id=455801
https://bugs.eclipse.org/bugs/show_bug.cgi?id=457852
https://bugs.eclipse.org/bugs/show_bug.cgi?id=459444

[LTTng Control] Fix Snapshot session support
LTTng Control 18.9 for LTTng Tools 2.5.4 https://bugs.eclipse.org/bugs/show_bug.cgi?id=459552

[TMF] Events in selection not updated in

Statistics View 4.1/4.2  statistics view https://bugs.eclipse.org/bugs/show_bug.cgi?id=459571
[TMF] Link with Editor not working for CTF

TMF Project View 12.5 traces https://bugs.eclipse.org/bugs/show_bug.cgi?id=459672

[GDB Trace] Content Column not displayed
GDB Tracing 4.3 anymore https://bugs.eclipse.org/bugs/show_bug.cgi?id=459711



https://bugs.eclipse.org/bugs/show_bug.cgi?id=459552
https://bugs.eclipse.org/bugs/show_bug.cgi?id=459571
https://bugs.eclipse.org/bugs/show_bug.cgi?id=459672
https://bugs.eclipse.org/bugs/show_bug.cgi?id=459711

